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1  Preface
1.1  Overview 
Beginning as an Open Source project in the year 2002, eXo is well-known as the industry's first 
Java portlet container. With the aim of dominating the potential portal market through robust 
and  easy-to-use applications,  eXo Project  succeeded in  attracting  consumers  in  the  whole 
world. eXo actually opened the floodgates to various options in many markets, and customers 
have been choosing eXo as the best method for their success. 

The  eXo  Platform™  software  is  a  powerful  Open  Source  corporate  portal  and  content 
management system. Users of the platform have a customized single point of access to the 
company's information system and resources. 

The foundation for  eXo Platform 3.0 is  eXo Core Services,  a powerful  set  of  REST-based 
services for rapid website development, content management and gadget-based development 
and deployment. eXo Extended Services are also a part of the eXo Platform 3.0 running on top 
of eXo Core Services to enable easy development of rich, user-centric web applications. 

eXo Content is one of eXo Core services, it provides a set of services to extend portal-based 
applications with Enterprise Content Management (ECM) capabilities. Document Management 
(DMS) features make it easy to catalog and organize enterprise content and  with powerful Web 
Content Management (WCM) services to quickly build dynamic, content-rich websites.
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1.2  Why use eXo Content
If you are looking for a powerful tool and strategies in managing website and contents, eXo 
Content  is  what  you  need.  eXo  Content  is  designed  to  provide  webmasters  who  manage 
websites the way of how to maintain, control, modify and reassemble the content of a web-page 
easily and effectively. Every components of your website can be orgnized, reconstructed easily, 
which  helps  you  keep  your  website  under  control.  eXo  Content  really  brings  interesting 
experience for all users and change their way of thinking about website. Followings are the eXo 
Content key features:

Website Creation

• Fast Setup:  Setup a new site in just a few clicks with an intuitive user interface and 
template features 

• Navigate, Preview and Publish Content:  Navigate through page content in either a 
single content viewer or the list content display, quickly preview page content or work on 
new content in draft mode and publish at anytime

• Templates:  Create  websites  from  exing  templates  and  themes,  or  create  new 
templates  with  a consistent look-and-feel across a single site

• In-site Edition:  The integrated rich text editor allows non-technical  users to edit the 
pages they are in charge of in an intuitive way

Web content organization

• Web-Based Administration:  Use a web browser to manage sites remotely, no local 
administration software is required.

• Manage Multiple Websites: Manage and control every site in one place

• Media Library:  Upload media to  the library,  publish,  reuse and update all  available 
media content across multiple websites

• Content Search: Search content and documents using categorization and tag features

• Broken Link Detection: Know how many broken links are present and how many are 
functional with ease

• Versioning & Rollback: Easily rollback a website's content with automatic versioning

• SEO & Friendly URLs: Search Engine Optimization (SEO) is simplified for editing meta 
tags and more. Content has its own specific URL for easier bookmarking and improved 
SEO

• Configuration  for  Deployment  on  Web  Farms:  Advanced  deployment  rule  for 
scalable, three-tier web application architecture with partitioned replicated deployment.

Capture & Manage Documents

• Kofax  Plugin:  Collect  paper  documents,  forms,  invoices  and  other  unstructured 
documents  and convert  into  accurate  and retrievable  information,  stored in  the eXo 
JCR.

• Access Control  List:  Validate the  current  session's  permissions  to add nodes,  set 
properties, remove or retrieve items. Define actions to launch the next step in a process, 
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or to invoke any "coded" action required

• Workflow: Specify processes for document collaboration and validation

• Record  Management:Track  the  status  of  content  completion  and  control  document 
storage lifecycles.

Store & Access Documents

• JCR:  eXo  JCR allows  applications  to  access  or  manage  files  independent  of  their 
location,  and  also  provides  advanced  features  such  as  unified  access  control, 
versioning, indexing and more

• Automatic Backup: Define and automate tasks to save documents as required

• Web Interface: Access documents in an intuitive and user-friendly web interface

• Microsoft & OpenOffice Plug-ins:  Microsoft and OpenOffice plug-ins give users the 
freedom to work on documents in their preferred document editing program.

And more: eXo Content also provides other powerful tools  to manage an build content-rich 
websites such as CSS, Java Script & RSS support,  advanced document management tool, 
collaboration tools, etc. All features is  to meet your requirements for the purpose of easy site 
management, cost reduction in managing multiple sites in only one place.

1.3  About this document
The  intended  reader  of  this  manual  are  webmasters  using  eXo  Content.  This  manual  will 
explain all the basic and advanced features that eXo Content provides  in managing websites 
and site content. It gives in-depth examples and easy explanations of eXo Platform technology 
that allows the webmasters to create and manage a very fast and powerful website.

By reading this manual, you will :

• learn the basic terminologies used in eXo Content 

• know how to create, manage and publish Site content

• know how to manage Web pages, set up a website, etc

1.4  References & related resources
Information

• eXo Home Page  

• eXo Wiki  

Support

• Forums  

• FAQ  
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Download

• eXo Content   

• eXo Development tools  

• Gatein Portal Framework  

• eXo Collaboration  

• eXo Knowledge  

• eXo Social  

Resource Center

• Video demos, tutorials, webinar archives, features & benefits tables and more  
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2  Overall Introduction
2.1  eXo WCM & DMS
eXo Web Content Management (eXo WCM) is the technologies used to Capture, Manage, 
Store,  Preserve,  and  Deliver  content  and  documents  related  toses.  It especially  concerns 
content imported into or generated from within an organization in the course of its operation, 
and includes the control of access to this content from outside the organization's processes. 

eXo WCM users can manage both structured and unstructured content, so that an organization, 
such  as  a  business  or  governmental  agency,  can  more  effectively  meet  business  goals 
(increase the profits or improve th organizational procese efficient use of budgets), serve its 
customers  (as  a  competitive  advantage,  or  to  improve  responsiveness),  and  protect  itself 
(against  non-compliance,  law-suits,  uncoordinated  departments  or  turnover  within  the 
organization). 

eXo  WCM improve  your  operational  productivity  and  efficiency.  It  allows  you  to  transform 
unstructured  content  into  structured  content  through  the  process  of  capturing,  storing, 
managing,  preserving,  publishing  and  backing  up  while  securely  distributing  it.  eXo WCM 
portlet gives you a portal solution that can help you achieve these processes and leverage your 
business content across all formats for competitive gain. It also provides an environment for 
employees to share and collaborate on digital content and delivering a comprehensive unified 
solution  with  rich  functionalities.  Every  components  of  your  website  can  be  organized, 
reconstructed easily, which helps you keep your website under control. 

Document  Management  System (DMS)  -  a  extension  of  eXo  Content is  used  to  store, 
manage and track electronic documents and electronic images and allows documents to be 
modified and managed easily and conveniently by managing versions, properties, ect . 

2.2  Site Content Structure
Creating a site is a quick process, but deciding what content to put in the site and how to 
organize it will take a lot of time. Thus, to mange a site more easily and more effective, a site 
always has a specific structure as following:
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The Site Content are stored in collaboration workspaces of Java Content Repository (JCR).

Details:

• CSS: This file is used to define the presentation of your entire site such as: font, color, 
size, etc.

• Documents: All documents, which are used in a site will be stored in this folder.

• JS: A programming script used on the site. This file is used to make a web page more 
animate and dynamic in terms of graphics and navigation.

• Links: This folder stores all links used in the site.

• Media: This folder includes three sub folders: 

Audios:  Store all sound files used in a site

images:  Store all images, pictures used in a site

videos:  Store all video files used in a site

• Web content: This folder is used to store the documents which present main content 
(texts images, hyperlinks, audios and videos) of the site.

2.3  Web Content
2.3.1.  What is Web Content in eXo WCM? 
Web Content is the textual,  visual  or  aural  content  that  is  encountered as part  of  the user 
experience on a website. It may include other things such as texts, images, sounds, videos and 
animations.

2.3.2.  Web Content Structure
As you know, a Web content may include various elements. Thus, to create and manage Web 
content more effective and dynamic, each Web Content also has a specific structure:

• Main content: It contains all key content such as: texts, images, links, tables,etc.

• Illustration:  It  contains  an  image  that  is  used  as  an  illustration  for  the  content. 
Additionally, a summary also can be added to come with this image.

• default.css:  It  contains CSS data which is used to present the web content such as: 
layout, font, color,etc.

• default.js: It contains JS data which is used to make web content more animating and 
dynamic.
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2.4  Terminologies
2.4.1  Repository
A repository is a place where data are stored and maintained. A repository can be:

• A place where data is stored

• A place where specifically digital data are stored

• A place where multiple databases or files are located for distribution over a network

• A computer location that is directly accessible to the user without having to travel across 
a network

• A place where anything is stored for probable re-usage

• A place to store digital data 

2.4.2  Workspace
A content repository is composed of a number of workspaces. Workspace is a term used by 
several software vendors for applications that allow users to exchange and organize files over 
the Internet. In the simplest case, a repository just consists of a workspace. In more complex 
case, a repository consists of more than one workspace. Each workspace contains a single 
rooted  tree  item.  The  “repository”  repository  contains  three  workspaces,  includes:  system, 
backup and collaboration workspace.

• System workspace: is used to reserve “system folders”

• Backup  workspace:The  backup  process  depends  on  the  published  content 
timestamps, each published document has a duration for which it can be published and 
when  it  exceeds  the  timestamps,  it  will  be  automatically  archived  to  the  backup 
database

• Collaboration workspace: Allows legal users to validate and manage documents

2.4.3  Drive 
A drive can be understood as a data storage device that is used to store folders with many 
documents in it. In a drive, folders are organized by a tree structure with sub-nodes are other 
folders or documents. In addition, you also may perform many supported actions on each object 
type. 

On the other hand, a drive is a customized workspace that consists of:

• a configured path from where the user will start when browsing the drive 

• a set of allowed views that, for example, will allow to limit the available actions (such as 
the edition or creation of content while being in the drive) 

• a set of permissions to limit the access (and view) of the drive to a limited number of 
people

• a set of options to describe the behavior of the drive when users browse it
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2.4.4  Node
A node is an abstract basic unit used to build linked data structures, such as linked lists and 
trees, and computer-based representation of graphs. Nodes contain data and/or links to other 
nodes. Links between nodes are often implemented by pointers or references.

A node can be thought of as a logical placeholder for data. It is a memory block which contains 
some data unit, and optionally a reference to some other data, which may be another node that 
contains other data. By linking one node with other interlinked nodes, very large and complex 
data structure can be formed.

2.4.5  Version
Versioning means that at  any given time the node's state can be saved for possible future 
recovery  and  the  action  of  saving  called  'checking  in'.  A  workspace  may  contain  both 
versionable and non-versionable nodes. A node is versionable if it has been assigned a mixin 
type mix: versionable;  otherwise, it is a nonversionable node. A version exists as a part of a 
version history graph that describes the predecessor/successor relations among versions of a 
particular versionable node.

Software versioning is the process of assigning either unique version names or unique version 
numbers to unique states of computer software. Within a given version number category (major, 
minor),  these  numbers  are  generally  assigned  in  increasing  order  and  correspond  to  new 
developments in the software. At a fine-grained level, revision control is often used for keeping 
track of incrementally different versions of electronic information, whether or not this information 
is actually computer software.

2.4.6  WebDAV

WebDAV stands for Web-based Distributed Authoring and Versioning. It is a set of extensions to 
the Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage 
files on remote World Wide Web servers. 
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The protocol was to make the Web a readable and writable medium. It provides functionality to 
create,  change  and  move  documents  on  a  remote  server  (typically  a  web server  or  "web 
share"). This is useful for, among other things, authoring the documents which a web server 
serves, but can also be used for general web-based file storage that can be accessed from 
anywhere. 

2.4.7  Podcast

A podcast is an audio file that you can download and listen to on your computer or a portable 
MP3 player such as an iPod. The word itself comes from the combination of two other words: 
iPod and broadcast. 

2.4.8  File Plan

The file plan is the primary records management planning document.  Although file plans can 
differ across organizations, their typical functions are to:

• Describe the kinds of items the organization acknowledges to be records.

• Describe what broader category of records that the items belong to.

• Indicate where records are stored.

• Describe retention periods for records.

• Delineate who is responsible for managing the various types of records.

2.4.9  Symlink
Symlink is a special file containing a reference to document or folder. By using symlinks, you 
can easily access specific nodes (target) that symlinks point to. In Sites Explorer, a symlink has 
a small chain symbol next to its icon:
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3  How to use eXo WCM & DMS?
3.1  Basic actions in eXo WCM
These actions can be done by users who have the right to use the administration bar with a 
personal preferences menu. 

3.1.1 Viewing a site
In the eXo WCM, we use the 'Website' term which is equivalent to the 'Portal' term. So, viewing 
a portal means viewing a website. You can select the site that you want to view by selecting the 
site name in the drop-down menu on the Administration bar:

The main screen of the site will appear like the illustration below:
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Illustration 1: The Interface of the Acme site

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

Detail:

Indicator Meaning

This is Administration bar which contains administration functions related to 
portals (websites). 

This is Banner which contains slogan, logo, icon used in the website.

This is Home page which is the main page of the website. This is the default 
page that is displayed first when you visit the website.

This is Footer of the web site. It can be texts, or image that is displayed at the 
bottom of the web site. It provides information about author/institutional sponsor, 
revision date, copyright, etc.

3.1.2 Register an account
To register a new account on the portal, proceed as follows:  

Step 1: Go to the portal by inputting the URL in the address bar (e.g: 

http://localhost:8080/portal/public/classic). The anonymous homepage will appear: 

Step 2: Click the Register link on the top of the site, the Register form will be displayed:
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Illustration 2: The eXo WCM in the public mode
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(*) required

The Account Setting information includes:

User Name The user name that is used to login into the system. It must be unique. The 
user name must be started with a character. 

Password The security characters are used to login. It must have at least 6 characters. 

Confirm 
Password

The re-typed password above. The password in Password field and this field 
must be the same.

First Name Your first name.

Last Name Your last name.

Email Address Your email address. It must have right format: username@abc.com

 

Step 3:  Input values for fields in this form.

Step 4:  Click the  icon to search and check if the inputted user name is available.

Step 5:  Input other required fields in the Account Settings tab.

Step  6:  Input  values  for  the  User  Profile  information,  including:  Profile  information, 
Home information, Business information. 
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Step 7:  Click the Save button to register a new account or the Reset button to renew 
all inputted values. There will be an alert message, and you can not add a new account 
successfully if at least one of these cases occurs:

• User name is existing or User Name is invalid.

• Password has less than 6 characters.

• Password and Confirm Password are not the same.

• Email Address is invalid format.

• Required fields are empty. 

After adding a new account, contact with the administrator to get the confirmation.

 

You should enter your email address exactly because when you forget username or password, you can 
recover it by using this email address. 
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3.1.3 Sign in
This function allows you to go into the eXo WCM in the private mode.

Do as follows:

Step 1:  Go to the eXo WCM in a public mode by inputting the URL in the address bar 

(e.g: http://localhost:8080//portal/public/classic/)

Step 2:  Click the Login link at the top of the home page. The Sign in form will appear:

Step 3:  Input your registered User name and Password.

Step 4:  Click the Sign in button to accept or Discard to exit the Sign in form.

Details:

User name To input the registered username.

Password To input the password of your username.

Forgot your User 
Name/Password

To retrieve the forgotten username or password when you forget.

Sign in To sign into the eXo Portal with the inputted username and password.

Discard To close the Sign In form without any changes. 

In case the User Name does not exist or the inputted User name/Password is invalid, 
there will  be an alert message that requires users to input right values. The page will be 
redirected to the private security check mode.

To login again, enter User Name and Password again.

After signing in, you will be redirected to the authenticated homepage:
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Illustration 3: The Sign in form
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Illustration 4: The main screen of the eXo WCM in authenticated mode
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3.1.4 Sign out
The function lets you get back to the anonymous portal. It ends your current portal session.

To sign out, click the Logout link on the right access banner:

or click the Start logo at the top left corner of the administration bar and select the Sign out 
form from the menu:

3.1.5 Retrieve username/password
In case you forget your account or password, you can recover by doing as follows:

Step 1: click the link Forget your User Name/Password? from the Sign in form. 

This form offers two options:

Forgot my password: If you forgot your password, you need to select this option. 

Forgot my username: If you forgot your username, you need to select this option.
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Step 2: Select one of these two options in this form. The selected option will be shown:

If the Forgot my password option is selected: 

If the Forgot my username option is selected:

Step 3:  Enter  your username or email in the corresponding form.

Step 4:  Click the Send button to send the inputted values.

Once  information  has  been  sent,  you  will  receive  an  email  with  your  User  name/ 

Password in your email address registered by you. 

• If you forget User Name:  when a username is retrieved, your old username is 

restored and can be reused and a new password  is also sent to your email with 

the old username.

• If you forget old password: a new password will be set (as temporary, then you 

will be directed to change the password for the next time you sign in.

  

   

The Username/Password that you received only takes effect for 1 day. It means that if the period is  
over 1 day from the receipt date, you can not use the receipt username/password, so you will need to 
get another email active
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3.1.6Change the displaying language
The priority order of displaying language is shown to the following order: 

 1. User's language 2. Browser's language 3. Portal 's language. Thus, to display your 

preferred language, you should pay attention to this order to change the language type 

appropriately. 

Step 1:  Click the Change Language link on the top left corner:

The Interface Language Setting form appears: 

Step 2:  Select the another language in the list. The currently selected language will be 

marked with the  icon.

Step 3:  Click the Apply button to change the displaying language temporarily and wait 

few seconds to take effect or click Cancel button to quit without any changes.
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3.1.7 Change the account information 
The function allows changing your account information.

Do as follows:

Click  directly  on  your  own account  name  to  open  the  Account  Profiles tab  which 

enables you to change your account profile or password.

The Account Profiles tab will appear: 

✔ To change your Account Profiles, do as follows:

Step 1: Select the Account Profiles tab.

This tab displays the current basic information of the user who has logged at the time.

Step 2: Change your First Name, Last Name, Email. You can not your User Name.

Step 3: Click the Save button to accept changes.

✔ To change your Password, do as follows:

Step 1: Select the Change Password tab.

                                 22 of 271

Illustration 5: The Account Profiles tab
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Step 2: Input your current password to identify that you are the owner of this account.

Step 3: Input your new password, it must have at least 6 characters.

Step 4: Input your password again in the Confirm New Password field.

Step 5: Click the Save button to accept changes.

3.1.8 Change the skin of the current site
The eXo skins are attractive user interface styles for displaying a portal. Each skin has its own 

characteristics with different backgrounds, icons, etc. In order to use easily and effectively, you 

are allowed to change the skin of the current site.

Step 1: Select the  Change Skin item in the menu that appears when you move the 

cursor to the logo at the upper left corner: 

The Skin Setting form appears:
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Illustration 6: The Password Changing form
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Step 2: Select the skin you want by clicking its name. 

Step 3: Click the Apply button and wait a few seconds to take affect. 

3.1.9 Print a web content
Users can easily print any content in a site by following these steps:

Step 1: Click Read more to read all the content of a document or an article in a site.

Step 2: Click  the Print button, the Print Preview page will be displayed on another tab.
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Illustration 7: The Skin Setting form
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Step 3: Click the Print button to print the content of this page or Close to close this tab 

without printing.
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3.2  Set up a website
In DMS, we use the 'Website' term equally to the 'Portal' term. It means that creating a new 

portal is creating a new website. Thus, you can also edit, delete, view a website as a portal.

Besides, DMS also supports webmasters/ administrators to manage websites better.

3.2.1 Create a new site
This function allows you to create a site (portal) to meet your own needs.

Do the as follows:

Step 1: Click Site on the administration bar. 

Step 2: A list of existing portals will be listed. Click the Add New Portal button to open 

the Add new portal form:

The add new portal form appears: 
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Illustration 8: The administration bar

Illustration 9: The list of the current portals
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Step 3: In the Portal Template tab, select Classic Portal or ACME Template for the 

new portal.

Step 4: Click the Portal Setting tab to set some properties for this site:
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Illustration 10: The Add new Portal form
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Details:

(*): required

Portal name The name of the portal. This field is required and must be unique. Only 
alphabet, numbers and underscore characters are allowed. The Portal 
name must be at least 3 characters

Locale The interface language of the portal. This field is required

Skin The skin of the portal

Step 5: Keep session alive by clicking the Properties tab.

The Keep session alive option means keeping the working session for a long time to 

avoid    the working time out. There are 3 options: 

• never : it never happens even if the application requests 
• on demand:  it starts to be used as soon as the application requests
• always: it's always enabled (which has a cost but the administrator will be aware of 

that) 

Step 6: Set access and edit  permission for this portal by clicking on the  Permission 

Setting tab.

The  Permission Setting tab includes two subtabs:  Access Permission Setting and 

Edit Permission Setting.

 The Access Permission Setting tab: By default, the access permission list of 

the portal is empty:
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Illustration 11: The Properties tab  in the Add new Portal form
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You can assign the access permission to everyone by checking the Make it public 
check  box  or  clicking  on  the  Add  Permission button  to  assign  the  access 
permission to a specific group which is selected from the Select Permissions form 
(By selecting a group on the left and a corresponding membership on the right):

After selecting groups, the access permission list is displayed:
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Illustration 12: The Select Permission form
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In which, the  icon is used to remove its corresponding group from the Access 

Permission list.

 The  Edit  Permission Setting  tab:  By default,  it  is  also empty and you have to 
assign the edit permission to a specific group.

You can assign the edit permission to a group with a specific membership by clicking 
the  Select  Permission  button  in  the  Edit  Permission  Setting tab  to  open the 
Permission Selector form. Select a group on the left panel and a corresponding 
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Illustration 13: The Access Permission list in the Permission Setting tab

Illustration 14: The Edit Permission Setting tab 
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membership on the right panel:

The (*)  from the Select a Membership panel means that you assign the right for 
everyone in the selected group from left panel.

After  selecting  a  group,  the  Current  Permission  will  be  displayed with  detailed 
information:

The edit permission is assigned for only one group at one time. You can click the Delete 
Permission button to remove the current edit permission of the selected group or re–
assign the edit permission to the another group by re-clicking on the Select Permission 
button and select another group.
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Illustration 15: Permission Selector form

Illustration 16: The Current Permission with the detailed information
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Step 7: Click  the Save button to accept creating a new portal.

After creating a new site, a list of the existing sites will be displayed on the screen. This 
new  site  will  be  added  in  the  exiting  sites  in  Site  on  the  administration  bar  and 
concurrently in a drive that includes all its default files. 

To see it in the drive, click Group on the administrator bar → Sites Explorer → Drive.

For example, after creating a portal named 'eXo', there is a drive named 'eXo' in Sites 
Explorer: 

3.2.2 Edit a site
This function helps you edit a site (portal). In addition to editing properties (setting, access/edit 
permission) of a site like a portal, you also may edit the layout components of that site. 

You have two modes:

• View mode: in this mode, you only can view the current portal (site) without editing the 
layout components of the site. When you sign in, by default, the mode of your site will be 
the view mode. This mode is the 'off' status of the edit mode.

• Edit mode: in this mode, you are either view or edit layout components of the current 
portal. 
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Illustration 17: Drives in Sites Explorer page
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3.2.2.1  Turn on the edit mode of the site

After signing in, you will see  two statuses (Live/Edit) of the edit mode on the Administration bar. 
By default, the status is 'Live'. It means that you only view the current site without editing the 
layout component of the site:

To switch between two statuses “Live” and  “Edit”,  just  click the   button on the 
corner to open the status list and select the mode you want: 

When  your  site  is  switched  to  the  edit mode  you  are  able  to  directly  edit  any 
components of your site:
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Illustration 18: The Site In Live Status
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3.2.2.2  The structure of a site interface
The interface of a site can be divided into five parts like the illustration below and each part is a 

single content viewer so that it also includes all default elements of a web content.
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Illustration 19: The site in Edit status
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Illustration 20: The Interface of the portal
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Detail:

Indicator Meaning

This is Administration bar which contains some administration functions 
related to portals (websites)

This is Banner which contains organization's slogan, logo, icon used in 
websites

This is Navigation bar that helps the website' s users to visualize the 
structure of website and provide quick links to different pages

This is the page content area to display the content of current selecting page

This is Footer of the website. It can be texts, an image that is displayed at 
the bottom of the website. It provides information about author/institutional 
sponsor, revision date, copyright, etc

3.2.2.3  How to edit a site?

✔ To edit a site, do the following steps:

a)  Edit the properties of the Website:

Step  1: Show  the  form  to  edit  the  current  site  by  clicking  Site  Editor on  the 

administration bar → select  . 

Step 2: The form to edit the current portal will appear.
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To edit the properties of the current portal, use one of icons below:

Indicator Meaning

          

Portal Properties: allows editing the portal's properties

          

Switch View Mode: allows turning on the view mode

          

Finish: allows saving all changes and escaping the Edit 
page

          

Abort: allows canceling all changes that have not been 
saved and quitting the Edit page

b) The layout of Edit Website:

You can only edit a banner, a navigation bar, a breadcrumb bar, a homepage and a footer of a 
website.

Edit banner

In eXo WCM, the banner is divided into two parts: a left banner and a right banner. You 
can edit both of them.

Step 1: Show the form to edit a banner by following steps :

                                 37 of 271

Illustration 21: The Edit Portal Form
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The 1st way:  Switch on the Edit Status on the homepage like illustration 21 and click the 
edit button on the homepage as this illustration below: 

The 2nd way:  Click the edit  icon at the right corner of the classic - banner portlet 

(for the left banner) or  classic- access portlet (for the right banner) in the Edit Portal 

form 

A form to edit the current banner will appear:
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Illustration 22: Edit left Banner
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Details:

The Main Content tab includes:

Name The default name of the banner. You can not change this value

Title The title of the banner. This field is required

Main Content The main displaying content of the banner

Save Draft Allow to save the current content as draft

Fast Publish Allow to publish immediately

Preference Allow to set some property for the web content

Close Close this form

Step 2: Change values in the Main Content tab of the edit banner form to edit the web 
site's banner. 

Step 3: Complete editing the site's banner and publish the content on the banner by 
clicking on the Fast Publish button. 

Step 4: If  you just want to save the edited content as a draft,  click the  Save Draft 
button. 
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Illustration 23: Edit right banner
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Step 5: To set some properties for the current content, click the  Preferences button. 
The Setting form will appear as you can see below. Change the information in this form 
and then click the Save button to save settings.

 The  Permission manager tab is used to set the edit and access permission for this 
content:

By default, when creating a new web content, all users can access but only 'root' and 
users of *:/platform/administrators group can edit the web content. In addition, you also 
can change these permission by doing as follows:

5.1 Edit  the  current  permission  of  a  group/user  in  the  Permission  table  by 

clicking on the edit icon  corresponding to that group/user. Then change 

the current permission by checking check boxes in the edit form below:

5.2  Or you can add new groups into the Permission table:

Select the  icon if you want to set permission for a user: The User selector 

form will appear like illustration 25.  Select a user in the list by clicking on the 

 icon.
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Select the   icon if you want to set permission for a group: Group selector 

form will appear like the below illustration. Select a group on the left and then 
select one corresponding membership on the right.

Select the  icon if you want to set permission for all users.

After selecting users/groups, set permission for these users/groups by checking 
the Access Right check box (for only the access right) or the Edit Right check 
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Illustration 24: The User selector form

Illustration 25: The  Group selector form
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box (for only the edit right) or checking both check boxes if you want.

5.3  Accept and save permissions by clicking on the Save button.

 The Configuration for Single content viewer tab includes:

Details:

Show title The option is whether to show the title of this content or not

Show print The option is whether to show the print function or not

The Illustration tab in the Web Content form:
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Illustration 26: The Illustration tab in the Web content form
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Details:

Illustration Image The path to an image that you want to upload into the site. This image 
will  be used like an illustration of that site.

Image Type The image format that you want to upload to the site.  The image file 
format can be gif, png, jpg or jpeg.

Summary You can give a short description about the web content because it will 
be displayed with illustration image when  the web content is listed. 
The main content will be show when it is selected to be viewed.

To upload an image to the site:

• Browse an image list on your local computer by clicking on the Browse... button 
and then select a specific location. 

• Select an image in the list to upload.

 The Advanced tab: 

this tab includes two parts: CSS data and JS data:

CSS data: contains CSS definition to present data in a web content. You can 
optionally enter CSS data into this field to specify the style.

JS data: It contains JS content to make the web content dynamically when being 
published. You can optionally enter JS content in this field.
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Illustration 27: The Advanced tab in the Web content form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

Edit homepage

eXo WCM helps you edit the main content displayed in the home page of a web site. 

Do the following steps:

Step 1: Show a form to edit the home page by clicking on the edit icon  at the 

right corner of the home page:

 The Web content form allows you to edit the main content in the home page:

Step 2: Change values in this form. 

Step 3: Click the Fast Publish button to accept changes and publish them on the home 
page, or click the Save Draft button to save the edited content as a draft.

Step 4: To set more properties for this content, click the Preference button.
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Illustration 28: The Edit homepage form in Single Content Viewer
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Edit footer

This function supports you to change the footer of the site.

Do the following steps:

Step 1: Show the form to edit the footer of the current site in two following ways:

The 1st way:

Step 1: Click the  icon at the right corner of the footer portlet in illustration 22. 
The form to edit the current footer will appear.

The 2nd way:

Click the edit icon  at the right corner of the site's footer. 

The form to edit the current footer will appear:

Step 2: Change values of this form.

Step 3: Click the Fast Publish button to accept changes and publish them on the home 
page. Or click the Save Draft button to save the edited content as a draft.

Step 4: To set more properties for this content, click the Preference button.
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Illustration 29: The Foot Edit form in Web content form
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The Banner, Home page and Footer of a site are shared to others. Thus, all their changes will impact on 
the entire site. So you should copy the shared banner, home page and footer to a specific portal folder 
and refer to them when you need

3.2.3 Switch between sites
This function is used to change the current web site by another one.

Just select a site in the site list that appears when you move the cursor to Sites on the 
Administration bar:

Your current site will be switched to the selected site.

3.2.4 Delete a site
This function is used to delete a portal (site) from the portal list.

Do the following steps:

Step 1: Show the portal list by clicking on Site on the Administration bar:

Step 2: Click  in the row of the portal that you want to delete.

Step 3: Click the OK button in the confirmation message to accept deleting.
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3.3  Manage The Site Content by Sites Explorer
3.3.1 Access Sites Explorer
This page is used to manage all documents in different drives. This is really the flexible way 
because  you  can  do  through  the  Internet  anytime  and  anywhere.  By  default,  anyone  can 
access Sites Explorer but the performing actions on Sites Explorer depending on the role of 
each user.

Go to Sites Explorer on the administration bar: 

By default, the Private drive will be displayed. To view all drives in Sites Explorer, click 

the icon:

There are some specific drives to choose to work on, they are organized in groups: 
Personal drives, Group drives and General drives.
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Personal drives:  Personal drive is the working space of a user. If you want to do in 
private, select the Private drive, no one else can access or get your private resources. If 
you want to create resource and share with others, work in the Public drive.

Group drives: The drive of a group is the working space of users in that group. 

In this example, the user “root” joins in three groups : “executive-board”, “administrators” 
and “users” so he has right to access these group's drive.

General drives: This is the working space for everyone but your access right in different 
drives depends on your role. With default users, log in by “root” or “john” you can access 
any drive in General drives, but if you login by “marry” or “demo” you only can access 
Shared Users Space and Validation Request Document Center only.
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3.3.2 Drives in Sites Explorer 

3.3.2.1  Private drive

Private drive contains personal  data of  registered users.  Hence,  only  these individuals can 
access data in this drive type.

By default, there are some initialized folders to store private user's resources. 

 By selecting the Actions tab, you can:

1. Create a new folder   

2. Create a new document   

3. Upload file from your computer  

4. Add Sym Links  

5. Overload Thumbnails  
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Illustration 30: The private drive
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 By selecting the Collaboration tab, you can:

1. Watch/Unwatch a document   .

2. Add tags for a document.  

3. Set multi-display languages for document.   

4. Vote for a document.   

5. Comment for a document.   

 By selecting the Search tab, you can:

1. Do the simple search   

2. Do the advanced search   with more constraints, add new query to search

3. Do search by existing queries  . 

 In addition, you can:

1. Setup your browsing preferences 

2. Cut/paste, Copy/past, Delete a node

3. Lock a node

4. Rename a node

5. Use the view WebDAV   function to view document content.

6. Download documents (folders) to your machine. 

3.3.2.2  Public drive
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With the Public drive, there's no initialized folder but you can create by yourself. In the Public 

drive, you also can take actions like in the Private drive.

3.3.2.3  Drive of a specific group

By default, there are two initialized folders but you also can add more and take actions like in 
Private drives. Only users in a specific group can access its drive.
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Illustration 31: The Public drive

Illustration 32:Platform/User group
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3.3.2.4  Shared Users Space drive

By default, there will be a list of all folders named after existing users, each user has a folder 
that includes two sub folders (private and public). You can see both your private and public 
folders here but you can see only the public folder of others.

 In this drive, you can:

Perform all actions that you can do in your private drive.

View nodes from public folder of others

 In this drive, you can not:

Add a folder/document in a root node

Add a folder/document in a folder named by other users and in child nodes of 
this folder.

Add a folder/document in a folder named by your username 

Rename a default folder

Lock folders named by a user

Delete a default folder

3.3.2.5  Show/hide the side bar in a drive

The side bar is used to show nodes like a tree or show the related documents, tags, clipboard 
and saved searches.
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Illustration 33: The Shared Users Space drive
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You can show/hide the side bar in 2 ways:

The 1st way:

Step 1: Click the  icon to open the  'Preference Setting':

Step 2: Unselect the Show sidebar check box. 

After closing the side bar, the drive will be displayed like the illustration below:

To show the side bar, select the Show sidebar check box in the  'Preference Setting'.

The 2nd way:

Simply click the border of this sidebar to hide it.
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Illustration 34: The preference setting

Illustration 35: The hidden side bar
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Click that border again to show the sidebar back. 

3.3.3 View types in Sites Explorer

eXo WCM supports  you four ways to view nodes in  a specific  folder and show actions of 
corresponding tab on the Actions bar. 

  The number of View types depends on what drive you are  browsing.You can manage the view types 
in eXo WCM Administration. See here for details

3.3.3.1  Details

In  this  view,  each  item  in  list  includes  following  information:  Name,  Date  Created,  Date 
Modified,  Owner,  Versionable and Auditing.  These information  will  help  you manage nodes 
easily.

You also can sort nodes basing on node information by clicking on the label of corresponding 
column. The  icon indicates that nodes are ordered in ascending order and on the contrary, 

the   icon means nodes are in descending order.
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3.3.3.2  Icons

In this view type, nodes in a specific folder will be viewed as icons. The name of each node will 
be shown under its icon.

3.3.3.3  Thumbnails

With thumbnails view, nodes in a specific folder are viewed as icons bounded by frames. Name 
of each node is shown under its icon. 

If nodes are image files, their thumbnails will be shown like the screenshot below: 
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Especially, in this view, you can  overload thumbnail image for node. For an example, if  you 
want to  add thumbnail image for Digital Assets folder, do as follows:

Step 1: Select a folder (on the left or right panel) that you want to add a thumbnail 

image.

Step 2: Click the  button to open the  Add thumbnail image form:

Step 3: Select an image used as a displaying icon for the selected folder by clicking the 
Browse... button. 

Step 4: Complete adding a thumbnail image by clicking the Save button. This node will 
be stored in a  exo:thumbnails folder.

Back to the parent folder (folder Pictures in this example) that contains the selected 
folder to see a icon used to display:
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Illustration 36: The Add thumbnail image form
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3.3.3.4  Cover flow

You can understand this view as a dynamical view because it brings the side – scrolling view to 
nodes in a folder. In this view, when a node is selected, its name is set with bold effect to more 
outstanding than others.

If nodes are pictures, they are shown like:

If nodes are documents or folders, they are displayed like the illustration below :

                                 57 of 271Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

To move from one node to another one, you can do any of these ways:

• Use the mousewheel.

• Hold and move the yellow circle button to the left or the right. 

• Click the folder/document name that you want to select.

3.3.3.5  Slide show

In this view type, pictures in folders are viewed in slide show. 

To view pictures in slide show, click the  icon: 

If nodes are pictures, they are displayed like the following illustration:
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The Slide show view automatically show all picture nodes, users can control this slide 

show by clicking on the below buttons:

Details:

Go to the first picture node.

View the previous picture node.

Pause the slide show. 

View the next picture node.

Go to the last picture node.

Continue viewing pictures node. 

3.3.3.6  Timeline

This view allows users to view all nodes created and uploaded by time. Just click the icon. 
All the nodes that were created and uploaded will be displayed like below:

You can click directly on the node name to view its content in details.
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You can also click the  to mark your item as favorite or the  icon corresponding 

to nodes in order to remove it from favorites.

3.3.4 Actions in Sites Explorer

3.3.4.1  Manage Site Resources in one place

You can easily manage all the site resources in Sites Explorer.

Chose  in General drive. All of your created sites and their resources will be 
listed in the left panel.

All sites contain typical folders:

a)  CSS

CSS is one of default files of a site. This folder contains CSS data that is used to present data in 

a site and increase that site's content accessibility. 
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Once a new CSS file in a site is created, it will affect on how the site will look. For an example, the color  
of the current site's background is black but when you create a new CSS file with red background 
color , all site's background will  be in red.

b)  Documents

This folder contains all documents used in a site. When you want to add a new document for a 

site, you also can put them outside this folder but you are recommended to put all documents in 

this folder to manage all site's documents easily and conveniently.

c)  JS

This is one of default files of a site. This file contains Java Script data that is used to make a site 
more animated and more dynamic.

d)  Links

This file contains all links used in a site.

e)  Media

This folder contains all documents related to videos, images and sounds. It is divided into three 
sub folders:

• audio:  This folder contains sound data used in a site.

• images: This folder contains images used in a site.

• videos: This folder contains videos used in a site.
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Illustration 37: Example of a 'Documents' 

folder
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f)  Web content

This folder contains all web content used in sites. You are suggested to put all web content files 
here to make use (in case you need to reuse web content files for creating a new site) and 
manage more flexibility.

3.3.4.2  Basic Actions in Sites Explorer
A web content is a key resource to make a site. Other resources make a site more dynamic and 

animated  by  using  layout,  color,  font,  etc.This  section  focuses  on  how to  manage  a  web 

content. 

a)  Create a new web content

This function is used to add a new web content into a specific site.

Do the following steps:

Step 1: Go to the drive of the site that you want to add a web content.

Step 2: Select the web content folder on the left:
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Illustration 38: Example of a 'Web content' 

folder
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In this step, you also can add a new web content into another folders (documents and media folder) 
of a site but you are recommended to select the web content folder because:

• Manage web content of a site more easily

• You only may add a new web content in this folder so that you don't need to select a web 
content document in the list of document types. It makes adding a new web content more 
flexibly

Step 4: Open the  Add New Document form by clicking on   on the 

Action bar.

Step 5: Select a template in the Select Template field to present web content:
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Details:

Select Template:

• Picture  on  head  layout  web  content:  The  site's  content  is 
presented in two spaces. One for inserting an image and one for 
editing the site's content. In which, the image is put at the head of 
a site.

• Free layout web content: This template is a free layout.

 The Main Content tab includes:

Name The name of a web content that you want to add new

Title The title of a web content

Main content The main content that you want to display when publishing 
this web content

Save button To accept saving the inputted values

Cancel button To exit the current form
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 The Illustration tab: 

It supports you to upload an illustration that makes the site's content more attractive. 

Details:

Illustration Image The path to an image that you want to upload into a site. This image 
will be used like an illustration of that site

Image Type The image format  that you want to upload to the site. It can be: 
image/gif; image/png; image/jpg; image/jpeg

Summary You can give short description about the web content because it will 
be displayed with the illustration image when the web content is listed. 
The main content will be shown when it is selected to be viewed

To upload an image to a site, do as follows:

• Browse an image list on your local computer by clicking on the Browse... 
button and then select a specific location. 

• Select an image in a list.

• Click the  icon to upload the selected image.
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• The Advanced tab: this tab includes two parts: CSS data and JS data:

CSS data: Contains CSS definition to present data in a web content. You can optionally 
enter CSS data into this field to specify the style.

JS  data:  Contains  JS  content  to  make  the  web  content  more  dynamic  when  after 
publishing. You can optionally enter JS content in this field.

Step  6: Enter values in fields of the Add New Document form.

Step 7: Click the Save button to accept adding new web content into a site.

By default, the web content created in Site Explorer is in Draft version

b)  Edit a web content

This function is used to edit a web content in a specific drive of an existing site.

Do the following steps:

Step 1: Go into the drive of a site which contains the web content that you want to edit.

Step 2: Select to view a web content by double - clicking it on the left tree or on the 
right. Detailed information of web content will be viewed on the right panel.
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Step 3: Click the button on the Action bar to show the edit form of the 

selected web content as

Step 4: Change current values in fields of this edit form.

Step 5: Complete editing the selected web content by clicking on the Save button.

  

   

When you click the button, the web-content will be auto-locked for your editing.  

After finish editing,  the content is back to unlock status. You can manage Locks in the  eXo WCM 
Admin portlet

c)  Delete a web content

This function is used to remove a web content from the web content folder in a specific site's 
drive.

✔ To delete a web content, do the following steps:

Step 1: Right click the name of the web content that you want to delete and then select 
Delete  in the menu:

Step 2: There will be a confirmation message. Click the OK button to accept the deletion 
or click the Cancel button to quit without deleting.

d)  Publish a web content

This function helps you publish a web content that you have added to web content folder in 
Sites Explorer.

✔ To publish a webcontent, do the following steps:

Step 1:  Go to the drive of  a site  which contains the web content  that  you want  to 
publish.

Step 2: Select to view it by double clicking it on the left tree or on the right.
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Step 3: Show the Manage publication form by clicking on  on the 

Action bar:

 The Publication status tab:

This tab lets you know about all statuses of versions. In which, you only may publish a 
content with the 'Live' status. There are four statuses for a content. They are:

• Enrolled: The revision is created but never be edited .

• Draft: The revision's already been created and it is editable. Thus you can still edit it 
if you want.

• Live: The revision can not be modified anymore. In this status, the content is ready 
for publication.

• Obsolete:  The revision is not live anymore and you should unpublish it  if  is  was 
published.
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You only can switch from one status to its next status. For example, your revision is in the Enrolled 
status and you only switch to the Draft status by clicking on the Draft icon. After being switched, 
your revision will be in the Draft status

 The Publication history tab: This tab is used to keep track of publishing history of a 
site: Select the Publication history tab in the above form to view detailed information 
(including: Date, New State, User and Description) of a site's publication:

If you want to change the position for publishing the selected web content, select the 
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current path and click right to left arrow to remove the path the select another location.

Step 4: Click the Close button to close this form and publish successfully.

After being published, all users who have the right to access that position can view the 
published web content as a page on the Navigation bar.

3.3.4.3  Manage Folders

a)  Create a new folder

You can create a document immediately in a specific drive; however, to manage documents 
better, the created folder should contain documents in it.

There are two types of folder:

• Content folder

• Document folder

In  default  skin,  the  icon for  a  content  folder  node is  displayed in  blue  and  the  icon for  a 
document folder node is displayed in yellow.

File and folder types in a folder

Content folder

✔ You can add a Content Folder folder into a Content Folder one.

✔ You can add a Document Folder folder into a Content Folder one.

✔ You can add documents into a Content Folder

✔ You can upload files (images, MS word documents, OpenOffice documents, .pdf 
files, .txt files, .xml file, etc) into a Content Folder

✔ You can import sub node(s) that was exported into a Content Folder

Document folder

✔ You can add a new Document Folder into a Document Folder

✔ You can add File, Podcast, File Plan documents into a Document Folder

✔ You can upload files (images, MS word documents, OpenOffice documents, .pdf 
files, .txt files, .xml file, etc ) into a Document Folder
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✔ You can not add a Content Folder into a Document Folder

✔ You can not import an exported a Content Folder into a Document Folder

✔ You can not import an exported Article, Sample node, Kofax into a Document 
Folder

Creating content folders

Do as follows:

Step 1: Select the path to create a folder. 

Step 2: Click the  button from the action bar. The Add a Folder form is 
displayed:

Step 3: Click the  icon to see type list and select the Content Folder type.

Step 4: Input value for the Name field. This field is required. You can not input some 
special characters in the Name field (@ # % & * ( ) “ ' : ; [ ] {} / !)

Step 5: Click Save to accept creating a new folder.

  

• A folder name can be the same with the existing one. When a new folder is created with the 

same name with other existing folder, after you click the Save button, its name will be added an 

index (e.g: test[2])

• You can only create a content folder in another content folder

Creating document folders

You can create a document folder in a content folder or a document folder.

Do as follows:

Step 1: Select the path to create a new folder.

Step 2: Select the Actions tab .
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Step 3: Click the button. The Add a Folder form appears:

Step 4: In the  Add a folder form, click the   icon to see the folder types list and 

select Document Folder.

Step 5: Enter a value for the Name field. This field is required. Some special characters 

are not allowed to inputted in the Name field: (@ # % & * ( ) “ ' : ; [ ] {} / !)

Step 6: Click the Save button to accept creating a new folder.

 

Like a content folder, A folder name can be the same with the existing one. When a new folder is 
created with the same name with other existing folder, after you click the Save button, its name will be 
added an index (e.g: test[2])

 

b)  Upload files into folders

This function supports you to upload a file from your machine. All file types can be uploaded. 
The uploaded file's name must not include some special characters (! @  $ % & + [ ])

✔ To upload file into folder, do as follows:

Step 1: Select the folder that you want to upload a file into from the left/right panel

Step 2: Select the Actions tab to show some actions on the Action bar.

Step 3: Click the   on the Action bar to open the Upload a file form:
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Step 4: Browse and select a file on your computer by clicking the Browse... button. The 
selected filename will be displayed in the Select a file field.

Step 5: You can change the uploaded file by clicking the  icon and select Browse... 

again to select another one.

Step 6: By default, the name of the uploaded file will be kept as original but if you want 
to change, you can type the new name in the Name field, this field is not required. The 
new name must not contain special characters: ! @  $ % & + [ ]

Step 7: You can click the  icon next to the List Taxonomy field to add categories for 

this file:

Step 8: Select categories by clicking the  icon. Click '+ '  to open child nodes of 

categories
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You can add more categories for a file by clicking the icon again to open the Add Categories form 

Click the icon to delete category in Upload a file form

You also manage categories which added for files by using the Manage Categories function. See   here  

Step 9: Complete uploading file by clicking the Save button.

Step 10: After being saved, the main information of the uploaded file will be displayed:

Step 11: Click the  icon to see more details of its external metadata information. The 

List external metadatas tab will be enable and you can input value in this tab.
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Step  12: Click  the  Save button  to  accept  changes  or  Cancel to  quit  without  any 

changes.

Step 13:data can be added for the uploaded file. Check the check box and then click 

the Add button or the Cancel button to quit without adding anything.

Step 14: New metadata is displayed in External Metadatas list and you also can edit it 

by clicking 

Step 15: Click the Close button to quit the Uploaded information form.

Step 16: After being uploaded, the tree is displayed in the left panel:
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Illustration 49: The Upload a file form

Illustration 50: The Add External Metadata form
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The size of the uploaded file depends on the size limit of the uploaded file that you set up in the 'Edit'  
mode of Sites Explorer. If your file size exceeds the limit,  a pop-up message will appears to alert you

If you want to upload multi files at the same time, click the   icon to open more 

forms to upload more files: 

Click the  Browse  button to upload files that you want to. The  trash   icon allows 
users to delete the upload file form.

c)  Add Sym Link

For the purpose of fast accessing the node that you want to look for in other nodes, adding a 
sym link for a node is an effective way to meet this need. 

✔ To add a sym link for a folder, do as follows:

Step 1: Select the node that you want to add a sym link.

Step 2: Select  the Actions tab to show some actions on the Action bar

Step 3: Click the on the Action bar. The Sym Link Manager pop-up will 

appear:
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Details:

Path Node The path of a link

Sym Link Name: The name of a link

Step 4: Click the  icon to open the Choose Target Node form

Step 5: Choose the workspace which contains the node that you want to add a sym 
link.

Step 6 Click the  icon in the row of the node that you want to add, the path of 

that node will appear in the Path Node field and the name of the node is set by the 
name of the selected node. You can also edit this name.

Step 7 Click the Save button to add a sym link.
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Illustration 51: The Sym Link Manager form
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You can select multiple nodes at once by holding the Ctrl or  Shift key and select nodes or 
move mouse over nodes. By using this feature, you can take some actions (copy, cut, delete, 
lock/unlock) on different nodes at the same time. 

d)  Copy/Paste Folders

There are two ways to copy folders to other places:

The 1st way: Copying/Pasting folders from the menu

Do as follows:

Step 1: Select a folder that you want to copy on the left or right panel.

Step 2: Right-click the selected folder and select Copy from the  menu:

Step 3: Select the path to the destination node that you want to make a copy.

Step 4: Right-click the destination node and select the Paste item in the menu.
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Step 5: The copied folder (and its sub folders) will be pasted to the new selected 
path. 

• You only can take the Copy action if you have a right on the source node

• You only can take the Paste action if you have a right on the destination node

• If the destination node has the same name with the copied node, after being pasted, the copy 
node will be added an index with its name. For example, in this case, if “new folder” contains a 
node with name “Live”, then after the paste action, in “new folder” there are two nodes with name 
Live and Live[2]

• You can not copy a content folder into a document folder

• After taking the Copy action, you can take the Paste action on different nodes before taking 
another Copy or Cut action

The 2nd way: Copying/Pasting folders from the Clipboard

Do as follows:

Step 1: Right-click a folder that you want to copy and select the Copy item in the 
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menu:

Step 2: Select a destination node that you want to make a copy

Step 3: Select the Clipboard item:

There will be a list of all copying/cutting actions waiting for being pasted.

Step 4: Click the   icon to paste the copied node into the selected destination 

node  in step 3.

Step 5: You can click the  icon to delete specific waiting statement.

Step 6: Or you can click the button to delete all waiting statements in list.

There  will  be  a  successful/unsuccessful  message  with  the  destination  path  or 
detailed reason after taking the Paste action.

• You only can take the Copy/Paste action if you have a right on the source/destination node

• If the destination node has the same name with the copied node, after being pasted, a copied 
node will be added an index with its name. For example, in this case, if “new folder” contains a 
node with name “Live”, after taking the Paste action, in “new folder” there are two nodes named 
Live and Live[2]

• You can not copy a content folder into a document folder.

• If there are more than one Copy/Cut action on 1 folder, in Clipboard only the nearest action is 
listed to wait for the Paste action.
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• If you delete the copy waiting statement from a Clipboard, the Paste action in a right-click menu 
also be deleted.

e)  Cut/Paste folders

There are two ways to move a folder from a current place to another one.

The 1st way: Cutting/Pasting folders from the menu

Do as follows:

Step 1: Right-click a folder that you want to cut then select Cut from the menu:

Step 2: Select the path to the destination node that you want to move to.

Step 3: Right-click a destination node and select Paste from the menu. Note that the 

Paste function is enable in the menu only after taking the Copy/Cut action.The cut 

node will be moved to a new place.

 

• You can do the Cut/Paste action only when you have a right on the source/destination node

• If a destination node has the same name with the cut node, after being pasted, the cut node 
will be added an index with its name. For example, in this case, if “new folder” contains a node 
named “Live”, then after the Paste action, in “new folder” there are two nodes named Live 
and Live[2].

• You can not cut and paste a content folder into a document folder.

• After the Cut action, you can take the Paste action only one time.

The 2nd way: Cutting/Pasting folders from the Clipboard

Do as follows:

Step 1: Right-click a folder that you want to cut and select theCut item in the menu.
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Step 2: Select the path to the destination node that you want to move to.

Step 3: Select the Clipboard item:

There is a list of all copying/cutting action and waiting for being pasted:

Step 4: Click the icon to paste a cut node into the selected destination node at 

step 3

Step 5:  You can click the icon to delete specific waiting statement

Step 6: Or you can click the Clear All link to delete all waiting statements in list.

• You can dothe Cut/Paste action only when you have the right on the source /destination node.

• If the destination node has the same name with a cut node, after being pasted, a cut node will  
be added an index with its name. For example, in this case, if a destination node contains a 
node  named “new”, then after taking the Paste action, in a destination node there are two 
nodes named “new” and “new[2]”.

• You can not cut and paste a content folder into a document folder

• If there are more than one Copy/Cut action on 1 folder, in a Clipboard only the nearest action is 
listed.

• If you delete the cut pending statement from a Clipboard, the Paste action in the right-click 
menu can also be deleted.

f)  Delete folders

This function helps you emove folders easily.

Do as follows:

Step 1: Right  click a folder that  you want to delete then select  Delete from the 
menu:

A confirmation message appears:
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Step 2: Click the OK button in the confirmation message to accept deleting or the 
Cancel button to quit.

• You only can take the Delete action if you have the right on a node

• If the deleted folder contains sub nodes, they are also deleted

g)  Drag and drop folders

This function supports you to move folders from a current location to an another one by using 
the drag and drop feature.

Do as follows:

Step 1: Move a cursor on a folder or folders (To select multi-folder at once: keep Ctrl 

or Shift key and select folders) on the right panel till the the cursor changes to . 

Step 2 Press the left mouse and then drag the selected folders to another folder on 

the right or left panel:
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Step 3 Drop them to the selected folder. All dragged folders will be moved to the 
destination folder.

h)  Lock/Unlock folders

This function supports you to avoid changes on a specific folder by others in a specific time.

Lock folders

Just right click a folder (from left or right panel) and select  Lock from the menu. The 
selected folder will be locked.

• Only users who have right can take this action

• After being locked, others can only view it

• The lock status can be kept in a current session only, if the locker sign out, the node will be 
unlocked

• Other users can make a copy of a locking node in other places by doing Copy and Paste it into 
another node but users can not remove it or perform other actions

• If you lock a folder but do not take any action on it, after 30 minutes, it will be unlocked 
automatically
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Unlock folders

To unlock a folder, right click a locked folder and select the Unlock item in the menu.

The locked folder will be unlocked and thus others can take actions on it.

i)  Rename folders

This function is used to change the name of a folder. 

Do as follows:

Step 1: Right click a folder that you want to rename then select Rename from the 

menu:

The Rename form will appear:

(*): required

Step 2: Input a new name in the Name field. You can also change the title of this 

folder by inputting new one in the Title field.

Step 3: Complete renaming a folder by clicking the Save button.
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j)  WebDAV View

WebDAV enables you to access files, folders and read and write documents over the web. Due 
to its benefits of easy, quick and flexible manipulations and time saving, WebDAV is used to 
view nodes.

✔ To view nodes in webDAV, do as follows:

Right click a node (from left or right panel) then select the Download and Allow Edition 

in the menu:

With each type of node, the form to view in WebDAV will be different:

✔ With folder:  the sub nodes list of the current folder will be displayed in WebDAV

✔ With 'nt:file' : the content of the document will be shown in WebDAV 

✔ with 'Article' : by default, it does not list any folder. But if Article includes some 

actions or added language, etc all folders will be listed with names: exo:actions, 

languages, etc

✔ With  'Podcast':  to  view in  WebDAV,  there  will  be  a  form that  users  have  to 

download this document.

✔ with 'Sample node' : by default,  it  lists folder name exo:image. Like Article,  if 

Sample node has some actions or added language, etc all folders will be listed 

with name: exo:actions, languages, etc

✔ With 'File  Plan' : by default,  it  lists folder named exo:actions. if  File plan has 

some  actions  or  added  language,  etc  all  folders  will  be  listed  with  names: 

exo:actions, languages, etc

✔ With 'Kofax' : like Article,  by default, it does not list any folder. When Kofax has 
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some  actions  or  added  language,  etc  all  folders  will  be  listed  with  names: 

exo:actions, languages, etc

With some documents like Podcast or office documents, you can not view the content directly, you must  
download it then use suitable application to view the content.

k)  Overload Thumbnails

You can easily overload a thumbnail image for a folder.

Do the following steps: 

Step 1: Select a folder that you want to overload a thumbnail image.

Step 2: Click the  on the Action bar:

The Add thumbnail image form appears:

Step 3 Click  Browse...  button to select  an image  used as a displaying icon for the 

selected folder.

Step 4 Click the Save button to complete adding a thumbnail image. The node will be 

stored in a  exo:thumbnails folder.
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3.3.4.4  Manage Documents in Sites Explorer

a)  Create a new document

There are several types of a document: File, Article, Podcast, Sample node, File Plan, Kofax.

See the table below to know what nodes that a document type can be added into (just see the 
rule in vertical):

File Article Podcast Sample 
node

File Plan Kofax 
document 

Content 
folder

Document 
folder

File o o o o o o o o

Article o x o x x o o x

Podcast o o o o o o o o

Sample 
node

o x o x x o o x

File Plan o x o x o o o o

Kofax o o o o o o o x

Uploaded 
file

o o o o o o o o

Content 
folder

o o o o x o o x

Document 
folder

o x o x o o o o

Note: 

“o” : The corresponding document can be added into

“x” : The corresponding document can not be added into

Follow the horizontal, you will know what the node can be added into

Follow the vertical, you will know what the node can include

The process  to create a new document is  similar.  You have to open the  Add New 
Document form, then choose a specific  document type (template)  that  you want  to 
create. 

✔ To create a new document, do the following steps:

Step 1: Select a folder from the left panel that you want to create a new document.
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Step 2: Select the Actions tab then click the button 

The Add New Document form will appear:

Step 3: Select the document type (template) that you want to create from the drop down 

list (Article is selected by default).

Each  document  (except  Article  document)  must  be  added  categories  when  being 
created.
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✔ To add categories for a document do as follows:

Step 1: Open the Add Categories form. See how to do this step here. 

Step 2: Click  to open a form to add categories for a document.

Step 3 Select  categories by clicking  the  icon.  Click  to  open child  nodes of 

categories (in the below screenshot, calendar is selected)

You can add more categories for a file by clicking the  again to open the 'Add Categories' form 

Click the  icon to delete category in the Add document form

You also manage categories which added for a file by using the Manage Categories function. For more 
information, see here
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Create a new File document

Step 1: Follow these steps to open the Add New Document form, then select File from 

the drop-down list.

The Add New Document form will be displayed like the following illustration:

(*): required

Step 2: Input name for file document in the  Name field. Some special characters 
can not be used in the Name field: @ # % & * ( ) “ ' : ; [ ] {} / !

Step 3: Click the  icon to see the Mime Type list and select one. There are two 

types of File document for you to choose:

• text/html: when creating a text/html File document, you can input value in the 
Content field like source code (HyperText Markup Language HTML). After being 
created, it will generate the content you want,then you can see both the inputted 
source code and the generated content in that document.

• text/plain: after being created, it  will  display exactly what you inputted in the 
Content field.html

Step 4: Input a value in the Content field.

• text/html: 

                                 91 of 271

Illustration 59: The Add new File document form
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If you want to create a File document with a source code and generated content, 

click the  icon in the editor bar. In this mode, only Save, New Page, 

Preview icons in editor bar are visible for using. Click the  icon to preview 

the generated content.

• Text/plain:

If you select text/plain type, the content field will be displayed like the following 
illustration:

Step 5: After inputting all required fields, click the Save button to accept creating a 
new file document or Cancel to quit without saving changes.

After being created successfully, a file document with type text/html will be displayed 
like the illustration below:
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Illustration 60:The View as HTML tab

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

Create a new Article

Step 1: Follow these steps to open the Add New Document form, then select Article 
from the drop-down list. (Actually, Article is selected by default)

The Add New Document form will be displayed like the following illustration:
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Illustration 61: The View as Plain text tab

Illustration 62: Add New Article form
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Step 2: Input the name and the title of the Article in the  Name and Title  field,  some 
special characters can not be used in the Name field (@ # % & * ( ) “ ' : ; [ ] {} / !).

Step 3: Input value for the Summary field and the Content field.

Step 4: Click the Save button to accept the inputted values or Cancel to quit. 

After being created, new added Article document will be like the illustration below:

The  Links  is  used  to  list  all  its  related  documents  .  After  adding  relations  for  a 
document,  Article will be displayed. You can click these links to view a content of the 
related documents. 

The Attachments is used to list all its uploaded files/documents that is attached with the 

Article. You can remove the attachments by clicking the  icon. 

You can learn how to attach files to a document here.

Document name can be the same with the existing one. When a new document is created with the same 
name as other existing document, its name will be added an index (e.g: test [2])
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Illustration 63: An example of an Article
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Create a new Podcast

Do as follows:

Step 1: Follow these steps to open the Add New Document form, then select Podcast 

from the drop-down list. 

The Add New Podcast form will be displayed like the following illustration:

(*): Required
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Illustration 64: The Add new Podcast document form
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Details: 

Name The name of a document. This field is required. Some special characters are 
not allowed to input in the Name field(@ # % & * ( ) “ ' : ; [ ] {} / !)

Title The title of a document

Categories Categories of a document

Link The link to the source path of the uploaded media file. This field is  required

Author The author of the uploaded media file

Explicit It is used to indicate whether or not your podcast contains an explicit material. 
There are two option:

• Yes: an "explicit" parental advisory graphic will appear next to your 
podcast artwork 

• No: you see no indicator – bank is default advisory type

Category The category of the uploaded media file, example: music, film, short clip, etc

Keyword Keyword allows you to search your podcast files more quickly. You can use 
commas to separate between keywords

Publish date The date when an episode was released

Description Information about the uploaded media file

Mime type The type of the uploaded media file

Length The length of the uploaded media file

Step 2: Input values for fields. To upload a media file, click the  Browse... button and 

select  the  media  file  from  your  machine.  After  that,  click  the  icon  next  to  the 

Browse... button 

Step 3: Click  the  Save button to finish or  the  Cancel button to quit  without  saving 
changes.

 

A document name can be the same with the existing one. When a new document is created with the 
same name as existing document, its name will be added an index (e.g: test[2])
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After being created, a Podcast will be displayed:

You can listen to a podcast immediately on your computer or transfer them to your audio 

player and enjoy later. 

Create a new Sample node

Do as follows:

Step 1: Follow these steps to open the Add New Document form, then select Sample 

node  from the drop-down list. 

The Add New Sample node form will be displayed like the following illustration:
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Illustration 65:  The screen of a Podcast
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(*) required

Step 2: Input values for fields. 

Step 3: To upload an image, click the Browse... button and select an image from your 
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Illustration 66: The Add new Sample node form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

computer. Click the upload  icon next to the Browse... button to upload the selected 

file.

Step 4: Click the Save to accept or the Cancel to quit without saving changes

After being created, a new sample node will be displayed like the illustration below:

The Relations area is used to list all its related documents. See here

You can click the links to view content of the related document.

The  Attachments area is used to list all its uploaded files. See how to attach files to 
document here
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Illustration 67:  The screen of a Sample node
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Create a new File Plan

Do as follows:

Step 1: Follow these steps to open the Add New File Plan form, then select File plan 

from the drop-down list. 

The Add File plan form will appear like the following illustration:

Details:

(*) required

 The Name Tab: 

Name Name of the file plan 

Categories The categories of your file plan. Select the categories for your file

 plan by clicking button

File Plan note Note for presenting any other handing information for users
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Illustration 68: The Add new File Plan form
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 The Record properties Tab:

            Details:

Record category identifier The alphanumeric or numeric identifier indicating a unique record 
category. This must be a unique ID and if left blank will be created 
automatically by the system

Disposition authority A reference number to the regulations that govern the disposition

Permanent record indicator A type of record indicators which should never be deleted

Disposition instructions A readable guidelines on how the records associated with the file 
plan will be handled

Contains records folder The confirmation is about whether the records folder is contained or 
not

Default media type The choice for preset media types which are made available to 
simplify the data entry for the record. The frequently-chosen value is 
"electronic" or paper

Default marking list Handling and classification information that are printed at the bottom 
of the record, such as UNCLASSIFIED or NOCONTRACT 

Default originating 
organization

This option is to enter the original arrangement as default which is 
made available to simplify the data entry for the record and to 
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Illustration 69: The Record properties tab
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assume that originating organizations are the same for the 
information in the file plan

Vital record indicator This flag is to allow whether tracking or reminding you of the record 
as essential or not

Vital record review period The choice for the interval of time between vital record reviews

 The Process Properties tab:

(*): required

• Process cutoffs: The boolean datatype is used to break a process. If the process 
cutoff flag is set in the file plan, the record is cutoff after the expiration, or after  it 
has been obsolete or superseded, depending on the information in the file plan. 

• Event trigger: The text datatype is an automatic executing code which is used to 
tell the event to perform some actions.

• Cutoff period: The duration for the record cutoff performance.

• Cutoff on obsolete: The record is cutoff when it is obsolete.

• Cutoff on superseded: The record is cutoff when it is removed or replaced.

• Process hold: This boolean datatype is used when a record process may be held 
before the further disposition is handled.
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Illustration 70: The Process properties tab
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• Hold  period:  The  duration  when  a  record  may  be  held  after  cutoff  which  is 
normally measured in Years.

• Discretionary  Hold:  The  boolean  datatype  is used  when  a  hold  may  be 
discretionary, such as after a command change. So, the discretionary hold flag 
allows the records management module to track these manual checks. 

• Process  transfer:  The  boolean  datatype  is  used  to  determine  how  a  record 
process will be transferred.

• Default transfer location: The text datatype is used to determine where a record 
is transferred by default.

• Transfer block size: The float datatype is used to determine in what size  blocks 
for organizational purposes that is normally measured in Years.  

• Process accession: The boolean datatype is flagged when a record which is held 
permanently must be ultimately transferred to the national records authority.

• Accession  location:  The  text  datatype  is  flagged  to  specify  an  area  for  the 
accession transfer.

• Accession block size: The text datatype is flagged to determine the blocks size 
for organizational purposes which is normally measured in Years 

• Process destruction: The boolean datatype is flagged if there is any record to be 
destroyed.  After  that,  the  record  is  marked  in  the  Alfresco  system  to  be 
permanently destroyed so that all information, metadata and physical traces are 
removed and cannot be recovered.

Step 2: Input values into these fields.

Step 3: Click the Save button to accept or the Cancel to quit.

After being created, new File Plan will be displayed:
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Create a new Kofax

Do as follows:

Step  1: Follow  these  steps to  open  the  Add New Kofax form,  then  select  Kofax 

document from the drop-down list. 

The Add New Kofax form will be displayed like the following illustration:

(*): required

Step 2: Input a name for a Kofax document in the  Name  field. This field is required. 

Some special characters can not be used in the Name field(@ # % & * ( ) “ ' : ; [ ] { } / !).

Step 3: Select categories for a Kofax document by clicking the  icon.
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Illustration 72:  The Add New Document form with the Kofax template

Illustration 71: The screen of a File Plan
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Step 4: Click the Save button to accept or the Cancel to quit.

After being created, a kofax document will be displayed like this illustration:

The File View tab is used to display all added nodes in that kofax. Besides, all added 

files in kofax are also displayed in the Document View tab:

Create new Event

Do as follows:

Step 1: Follow these steps to open the Add New Event form, then select Event from 

the drop-down list. 

The Add New Event form will be displayed like the following illustration:
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Illustration 73: The Kofax Document view tab

Illustration 74: The Kofax File view
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(*): required

Step 2: Input Title for the event

Step 3: Input the location where the event will take place in Location field. Check the 

Google Maps checkbox if you want the location of the event shown on Google Maps.

Step 4: Input the Start and End Date/time of the event.

Step 5: Fill the Summary and Content filed

Step 6: Click Save button to finish or Cancel button to  quit without saving changes.   

After being created, the event wll be displayed like the illustration bellow:

That's how this event will be displayed on a website:
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Illustration 75: Add New Event form
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b)  Attach files to a document

Do as follows:

Step 1: Select a document that you want to attach files then click the 
button from the Actions tab:
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Step 2: The Upload file form will appear:

Step 3: Input the file name in the Name field. 

Step 4: Click the  button to select your attachment. You can also click 

icon to select another file to upload.

Step 5: Click Save to attach your files or Cancel to quit without changes. 

c)  Edit documents

There are two ways to edit a document:

Do as one of follows:

The 1st ways: Select the document that you want to edit on the left panel.

Step 1: Select the Actions tab to show available actions on the Action bar.

Step 2: Click the  on the Action bar.

The 2nd way: Select a folder that contains the document you want to edit

Step 1: Right-click the document you want to edit and select  Edit from the menu.

The Edit Document form will appear. All information of the selected document will 

be displayed in this form and ready for you to change except the Name field.

Step 2: Click the Save button to save new changes.
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d)  Delete documents

Do as follows:

Step 1: Select a document that you want to delete on the left panel.

Step 2: Right-click the document and select Delete from the menu.

Step 3: Click OK button in the confirmation message to accept or Cancel to quit.

By moving the cursor on the document name and then right-click that document, there will be a 
menu that includes main basic actions on documents.

   You can select multiple nodes by holding the Ctrl, Shift key and select nodes or move mouse over 
nodes. By using this feature, you can take some actions (copy, cut, delete, lock/unlock) on different  
nodes at the same time

e)  Copy/Paste documents

This function is used to make a copy of a document (include sub nodes) in other places. There 

are two ways to cope/paste documents:

The 1st way: Copying/Pasting documents from the menu

Do as follows:

Step 1: Right-click a document then select the Copy from the menu. 

Step 2: Select a destination node that you want to make a copy

Step 3: Right-click the node you want to be the parent node of the copied node and 

select the  Paste item in the menu. Note that the  Paste function is enable in the 

menu only after selecting the Copy/Cut action.

Step 4: The copied document (and its sub nodes) will have a copy in a new selected 

path.

  

 

• You only can take the Copy/Paste action if you have a right on the source node

• If the destination node has the same name with the copied node, after being pasted, the copied 
node will be added an index with its name

• After taking the Copy action, you can paste that node on different nodes before taking the new 
Copy or Cut  action

 The 2nd way: Copying/pasting folders from the Clipboard

Do as follows:

Step 1: Right-click a document and select the Copy from the menu. 

Step 2: Select the destination node (a folder or a document) that you want to make 

a copy

Step 3: Select the Clipboard icon : 
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Step 4: Click  the icon to paste the copied node into the selected destination 

node in step 3

Step 5: You can click the icon to delete a specific waiting statement

Step 6: You can also click the Clear All link to delete all waiting statements in the 
list.

There is a message with the destination path or detailed reason after taking the 
Paste action.

  

   

• You can do the Copy/Paste action only when you have the right on the 
source/destination node

• If the destination node contains a same named node with the copied node, after being pasted, 
the copy will be added an index after its name. 

• If there are more than one Copy/Cut action on 1 folder, in Clipboard only the nearest action is 
listed waiting for Paste.

• If you delete the copy pending statement from the Clipboard, the Paste action in the right-click 
menu also be deleted.

f)  Cut/Paste documents 

There are also two ways to cut/paste documents from one place to an another place.

The 1st way: Cutting/Pasting documents from the menu

Do as follows:

Step 1: Right-click a document and select the Cut from the menu. 

Step 2: Select a path to the destination node (a folder or a document)

Step 3: Right-click the node that you want to paste the cut document and select the 
Paste item in the menu. The Paste function is enable in a menu only after selecting 
the Copy/Cut action.

Step 4: The selected document (and its sub nodes) will  be removed to the new 
selected path.
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The 2nd way: Cutting/Pasting documents from the Clipboard

Do as follows:

Step 1: Right-click a document and select Cut from the menu. 

Step 2: Select a path to the destination node you want to move to

Step 3: Select the Clipboard icon :

There is a list of all copying/cutting actions waiting for being pasted.

Step 4: Click the  icon to paste the cut node into the selected destination node 

in step 3.

Step 5: You can click the  icon to delete specific waiting statement.

Step 6; You can also click the Clear All link to delete all waiting statements in the 
list.

There will be a message with a destination path or detailed reason after taking the 
Paste action.

• You can do the Cut/Paste action only when you have the right on the source/destination 
node.

• If the destination node contains a same named node, after being pasted, the cut node will be added 
an index after its name. 

• If there are more than one Copy/Cut action on one folder, only the most recent action is listed  in 
the Clipboard

• After performing the Paste action, the waiting cut statement will be removed automatically.

• If you delete the cut waiting statement from the Clipboard before paste, the Paste action in the 
right-click menu also be deleted.

g)  Drag and Drop documents

This function allows you to move a document from a specific location to another one by using 
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the drag and drop feature.

Do as follows:

Step 1: Move a cursor on a document or documents (To select multiple documents 
at once: hold the  Ctrl key and select documents) on the right panel till the cursor 

change to . 

Step 2: Press the left  mouse and then drag the selected documents to another 
folder on the right or left panel.

Step 3:  Drop them to the selected folder. All dragged documents will be moved to 
the destination folder.

h)  Lock/Unlock documents

This function supports you to avoid changes on a specific document by others in a specific time.

Lock document

To lock document, do as follows:

Step  1: Select  the  path  to  the  document  that  you  want  to  lock  or  select  the 

document on the left/right panel.

Step 2: Right click that document and select Lock from the menu:

Step 3: After  this  action,  the  document  is  locked,  only  you  is  allowed  to  make 

changes on this document.

• Only users who has a right can take this action.

• Others can only  view document after it has been looked.

• The lock status can be kept in your current session only, if the you sign out, the node will 
be unlocked automatically.

• Other users can make a copy of a locking node in other places by doing Copy and Paste it into 
another node but users can not remove it or perform others actions.

• If you lock the document but do not perform any action on it, after 30 minutes, it will be unlocked 
automatically. 

Unlocking documents

After a document has been locked, when right-click it, the Unlock item in the menu will 

be enabled only when a document is being locked. Select it and the locked document 

will be unlocked.  After that, others can take actions on it.

i)  Rename documents

This function is used to change the name of a folder. 

To rename document, do as follows:
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Step 1: Right click a document and select the Rename item in the menu.

The Rename form will appear:

Step 2: Input a new name for this node in the Name field. You can also change the 

title of this document by inputting new one in the Title field.

Step 3: Click the Save button to accept or the Cancel to quit.

 

Renaming a document must follows rules of creating a new document: 

Some special characters can not be used in the Name field (@ # % & * ( ) “ ' : ; [ ] {} / !)

A document name can be the same with the existing one. When a new document is created while its 
name has been existing, after clicking Save, its name will be added an index (e.g: test[2])

j)  Add Sym Link

You also easily add a sym link for a document for the purpose of fast accessing the document 

that you are looking for:

To add Sym link, do as follows:

Step 1: Select a document that you want to add a sym link.

Step 2: Right click that document and select Add Sym Link from the menu.

Step 3: The selected document will be added a sym link immediately. You now can 
click the sym link to view its content.

k)  View WebDAV

WebDAV enables people to access files, folders and read and write documents over the web. 
Due to its benefits of easy, quick and flexible manipulations and time saving, WebDAV is used 
to view nodes.

 To view nodes in WebDAV, do as follows:

Step 1: Select the path of node you want to view webDAV or open that folder from 
the left/right panel.

Step 2: Right click node and select the  Download and Allow Edition item in the 
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menu.

Step 3: With each type of node, form to view in WebDAV will be different:

• With folder:  sub nodes list of current folder will be displayed in WebDAV

• With 'nt:file' : the content of document will be shown in WebDAV 

• With 'Article' :  by default, it does not list any folder. But if Article includes 
some actions or  added language,  etc all  folders will  be listed with name: 
exo:actions, languages, etc

• With 'Podcast':  to view in  WebDAV, there will  be a form that  user has to 
download this document.

• with 'Sample node' : by default, it lists folder name exo:image. Like Article, if 
Sample node has some actions or added language, etc all  folders will  be 
listed  with name: exo:actions, languages, etc

• with 'File Plan' : by default, it lists folder name exo:actions. If File plan has 
some  actions or  added language,  etc all  folders will  be listed with name: 
exo:actions, languages, etc

• with 'Kofax' : like Article,  by default, it does not list any folder. When Kofax 
has some actions or added language, etc all folders will be listed with name: 
exo:actions, languages, etc

 

With documents like Podcast or office document, you can not view the content directly, you must  
download to your computer then choose the suitable application to view the content

l)  Add to favorite

This function helps users easily add nodes (documents, folders or files)  as favorite. 

✔ To add a document as your favorite, follow these step:

Right  click  the  document  that  users  want  to  add  it  as  favorite  and  select 

 from the menu.                                  

There will be a symlink of your favorite nodes (folders, documents, files) will be created 

in the Favorite folder.  

m)  Watch/Unwatch documents 

By using this function, whenever a change is made on the document, there will be a notification 

message sent to your email address.  To receive that email, you must configure in your mail 

server.

✔ To start receiving an email notification do as follows:

Step 1: Select the document.
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Step 2: Chose the Collaboration tab then click the button from the action bar. 

Step 3: The Watching Document form will appear. Click the Watch button to finish.

✔ To stop receiving an email notification, select the document you want to stop watching. 

Then click the button again.  There will  be a message informing that  you've just 

unwatch that document.

n)  Add tags for documents

A tag is a (relevant) keyword or term associated with or assigned to a piece of information (a 

picture, a geographic map, a blog entry, a video clip etc.), thus describing the item and enabling 

keyword-based classification and search of information. 

Adding a new tag for a document

Do as follows:

Step 1: Select a document that you want to add tags.

Step 2: Chose the  Collaboration tab then click the  button 

on the Action bar. The Tag Manager will be displayed:
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Illustration 77: The Tag Manager form
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Tag names The tag names that users want to add tags for documents

Tag Scopes To classify tags. There are four tag types: private, public, group, site. Currently, the 
two first types are activated(Private: a user who create tags can view and edit tags; 
public: all users can view and edit tags )

Linked tags To list all tags of a document after you click the Add Tags button

Step 3: Input a value for the  Tag names field. A document can be added several 
tags at a time. To do that, input all tag names in the Tag names field and separate 
by “,”

Step 4: Select a value for the Tag Scopes field.

Step 5: Click the Add Tags button to accept or the Close to quit. Only you can see 
this tag in this document. 

Step 6: Click the trash   icon to delete tags that you want to. 

A tag name can not contain some special characters, including: ! @ $ % * [ ] ' : \ /

You can add multi-tags for the same documents.

You can add multi-documents with the same named tag.

All tags of a document will be listed in Linked tags.

When you add a tag for a document, anyone can select that tag so anyone can see your document but 
they only can take actions on it if they have the right.

o)  Use created tags

Select the Tag cloud icon, you will  see all  existing tags: All  existing tags are listed and 

classified by private or public tags.

Depending on the popularity of tag, the displaying of each tag will be different from others by: 

font-size, font-weight, color, font-family, text-decoration. For example, when a tag is added for 

over  10  documents,  it  will  be  displayed  in  red  color,  size:20px,  bold.  This  is  also  can  be 

configured in eXo WCM Administration portlet. 
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Each tag is also like a link used list all documents that it is added, click a tag name, documents 

list will be displayed in the right panel. 

p)  Manage tags

A user easily manage tags by editing or deleting tags. Follow these steps:

Step 1: Click the  icon at the upper right corner of the private or public tags panel. 

The Edit tag form will appear:

Step 2: Click the icon that corresponds to the tag name you wants to edit

Step 3: Change the tag name for the Tag name field

Step 4: Click the Save button to accept changing a tag name or the Cancel button 
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Illustration 78: The Edit tag form

Illustration 79: The Tag form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

to close the Tag form without changing a tag name.

A user  also  can  delete  a  tag  name  by  clicking  on  the icon.  A confirmation 

message will appear.

Click the OK button to accept deleting or the Cancel button to close this message 

without deleting a tag.

q)  Add language for a document

This function is used to support users to add multi-languages for a document. Each document 

can be displayed in many languages that are added. 

Do as follows:

Step 1: Select a document that you want to add language(s).

Step 2: Select the Collaboration tab to show some advanced actions on the Action 

bar.

Step 3: Click the   button on the Action bar.

The Multi language form will appear:
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In the View language tab, there will be a list of all language for selected document. You 

also  know what language is currently set as default for your selected document.

Step 4: Select the Add language tab, depending on what file you selected, this tab will 
be displayed differently, however, the area where you can add languages for document 
is the same. The below illustration shows the Add language tab for a Sample node file:

Step 5: Select a language you want to add from the Language drop-down list.

If the selected language has not been added for current document, the content field will 
be blank.

Select the Set default checkbox if you want to set your selected language as default 
language.
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Step 6:  Click  the  Save button,  you will  be  back  to  the  View language tab.   Your 
selected language is now added into the Language field:

You can view this document in new added language by selecting the language from the 
language drop-down list then click the View button.

✔ To view the languages list of a document, do as follow:

Step 1: Select a document that you want to view the language list then click the Relation 
button on side panel:

Step 2: The list of language (and all related documents ) will be displayed on the left 
panel:

You can view the document in new language by clicking on the corresponding link in 
Languages List.
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For more details about Relations, see here

    You can not add multi-language for a File Plan.

When a document is a sub-node of a File Plan you also can not add language for it.

r)  Add translation for a document.

This function is used to support users to add multi-languages for a document. It's similar to the 

Add language function but more flexible. 

By default, the Add translation button is not displayed on the toolbar. You have to enable this 

function by going to Sites Administration -> Content Presentation -> Manage Views

✔ To add translation for a document, do as follows:

Step 1:  Select the document you want to add translation. For example, select an 
Article which is in English:

Step 2: Click on the                             button on the Action bar.

The Symlink manager will appear:

Step 4: Click the       button then browse to the target document that's has different 
language with the first document. In this example, let's browse to the Article which is 
in French version.

                                 121 of 271Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

Step 5:  After  you select  the document click  the  Save   button on the  Sym Link 
manager form:

Select the document which you have added translation, then click on the relation 
button  on  the  side  bar,  you  will  see  the  available  language  for  the  selected 
document.  Click  on  the  language  on  this  panel  to  view  the  document  in  the 
corresponding language version.
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s) Add language for an uploaded file

To add new language for an uploaded file, do as follows:

Step 1: Click Browse to select a file from your computer then click the upload icon 

Step 2: Input value in the Name field if you want to change the displaying name of 
the uploaded file.

Step 3: Click the Save button to accept inputted values.

t)  Vote for documents

This  function  is  used  to  vote  for  a  document.  In  which,  you  can  not  vote  for  a  File  Plan 

document.

To vote for a document, do as follows:

Step 1: Open a document you want to vote.

Step 2: Select the Collaboration tab to show some advanced actions.

Step 3: Click the  button.

The Vote Document form will appear:
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Step 4: Mouse over the stars to rate the document and click to set your rating.

After  being  voted,  the  vote  information  will  be  displayed  at  the  bottom  of  the 

document:

u)  Comment on documents

This function supports you in adding a comment for a specific document. However, you can not 

comment for a File Plan document.

To comment for a document, do as follows:

Step 1: Select the document that you want to add comments.

Step 2: Select the Collaboration tab to show some actions on Acton bar:
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Step  3: Click  the button.  The  Add  Comment form  will 

appear:

Step 4: Input the content in Comment (this field is required). 

Step 5: Click the Save button.

The content of your comment will be displayed at the bottom of the document:

To view your comment click the Show comments link. The content will be displayed:

You can also edit your comment by clicking on the icon or delete it by clicking on 

the  icon next to it.
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3.3.5 Search in Sites Explorer

There are three ways to search an existing node: Simple search, Advanced search & Quick 
search.

3.3.5.1  Simple Search

This function is used to search by the properties of the document except document's name.

Do as follows:

Step 1: Input a string that is existing in a document you want to find (not in name)

Step 2: Click the magnifying glass icon  to search.

The search result will be returned in the right panel.

• If there is no node containing the search term, the search result will be empty

• If the searching string is existing, the search result will be listed:

Click the  icon in the Action column to view the content:
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You can also click the icon to go to the node that contains the corresponding search 

result. After clicking this icon, the node containing that search result node will be shown . 

3.3.5.2  Advanced search

✔ To open the advanced search, do as follows:

Click  the  Saved  Searches icon then the  Advance Search icon to open the 
Advanced Search form.

The Advanced Search form appears:
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There are more options for you to search: search by Name, search with constraints, 

search by new/existing query.

a)  Search by name

To search nodes by a name, select the first Search by Name tab and do as follows:

Step 1: Input exactly the name of the node that you want to search.

Step 2: Click the Search button. It will return with the message “No result found” if there 

is no node with the searching name. If the searching name has been existing, the result 

will be return in the Search Results tab like in simple search. 

b) Search with constraints 

This kind of search allows you to search with more constraints to limit the returned results.

Current location is the path that you selected to search.

By this way, you can do like a simple search by inputting the search term into A word or 
phrase in  the content field and then click Search. The result  will  be returned in the 
Search Results tab.

You can also search with more constraints by doing as follows:

Step 1: Input the search term that you want to search in the content fields of nodes.

Step 2: Select the Operator
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• Select AND when you want to combine the inputted string and the constraints will 

be added after selecting an operator. The search result will  not be blank only 

when there's a node that meets both conditions (the phrase and the constraints).

• Select OR when you want to combine the inputted string and the constraints will 

be added after selecting an operator. The search result will not be empty when 

there's a node that meets at least one of two conditions (the phrase and the 

constraints)

Step 3: Click Show/hide constraints form button to add more constraints. 

The adding constraints form will appear: 
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Details:

1 You can add more than one constraint thus there are two operators AND and OR for 
you to combine them.

2 These fields allow you to add a constraint to search by a property with specific values.

3 These fields allow you to add a constraint to search by a property with specific values.

4 These fields allow you to add a constraint to search by a property that contains one of 
the word in the specific string.

5 These fields allow you to add a constraint to search by a property that does not 
contain the specific string.

6 These fields allow you to add a constraint to search by a duration of date (created, 
modified).

7 This field allow you to add a constraint to search by the document type (File, Article, 
Podcast, Sample node, File Plan, Kofax)

8 This field allow you to add a constraint to search by categories

Add node type

Add category 

      

Step 4: Select the constraint operator (AND/OR)

Step 5: Check the check box corresponding to the row you want to add a constraint. 

▪ 5.1 To add a constraint to search by properties with exactly values, do as follows:

1. Check the check box corresponding to the one you want to add a constraint 

2. Input the property you want to find or click the Add Property icon .  
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 A form to select properties appears:

3. Check one in list and click the Add button. Checked property will be added in 

the Property field.

4. Input a value in Contain exactly or click Find exactly  icon.

5. If  there are documents that have dc:title property,  there will  be a list of all 

values in this field for all documents. 
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If there's the value you want, move the cursor on name and click. The selected one 
will be marked by a blue color. Then click the Select button. The Filter field is used 
to limit the number of results below. Input the string that you want to limit and then 

click  right next to it. The filter result will be returned below. The selected value 

will be displayed in the Contain Exactly field.

▪ 5.2 To add a constraint to search by properties with exactly values, do as follows:

1. Check the check box corresponding to the one you want to add constraints  

2. Input the property you want to find or click  Add Property icon .

3. Input value in the Contain or Not Contain field.

4. Click the Add button.
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▪ 5.3 To add a constraint to search by duration of date, do as follows:

1. Select the check-box corresponding to the one you want to add constraint  

2. Select the search condition from the list (CREATED, MODIFIED)

3. In From or To field, click the cursor in the textbox, a mini calendar will appear 

for you to choose date easily.

4. Select the From date and do the same with To date. The selected date will be 

displayed:

▪ 5.4 To add a constraint to search by document  type, do as follows:

1. Check the check box corresponding to the one you want to add constraints 

2. Input the document type that you want to search or click . There will be a 

list of all document types.
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3. Check the checkbox of the document type you want and then click the Save 
button.

4. Checked document types will be displayed:

▪ 5.5 To add a constraint to search by categories, do as follows:

1.  Check the check box that  corresponds to the one which you want  to add 

constraints 
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2. Input the categories to search or click  . 

A list of all categories will appear:

3. Click   on a category you want to select. The selected category will be 
displayed in the Category field.

4.  Click  the  Add button  to  add  created  constraints.  The  constraint  will  be 
generated to SQL query and displayed in search form:

To remove a constraint, just click the corresponding trash icon 

To start searching, click the Search button. The search results are displayed in 
the Search Results tab.

To save the search you've created, click the Save button, input the query name 
and click the Save button in add new query form.
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c)  Search by creating a new query

Select the New Query tab:

This requires you have to know about the structured and query statements.

There are two types of query for you to choose: SQL and xPath. 

✔ To create new query, do as follows:

Step 1: Input a query name, it must be the unique.

Step 2: Select a query style.

Step 3: Input a query statement.

Step 4: Click the Search button to review the search result and display search result in 
the Search Results tab or  the Save button to accept creating new.

Step 5: The new saved query will  be displayed in existing queries list  in the  Saved 
Query tab.

d)  Search by existing queries

Select the Saved Query tab:
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This is the list of all existing queries that you have a right to use. In this example, the first 
query is the system query, it is created by Administrator, you can not edit or remove it.

Click  to see the search results in the Search Results tab

Click if you want to change the query statement. The editing form appears like when 

you create a new query but you can not change its name.

Click if you want to delete the query (note that you must have the right to delete the 

query to perform this action).

3.3.5.3  Quick search
This is the quick way for you to use the existing queries to search.

Step 1: Click the  icon to see the existing queries list.

The existing query list will be appeared: All Articles,Created Documents, 

CreatedDocumentDayBefore, and allArticles.
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Step 2: Do the same like when you do the advanced search in the Saved Query tab.

The panel: All Items and By Type helps you filter documents, files, folders according to 

items: Owned by me,  favorites,  hidden or by types:  content,  documents,  images, 

music and video.

Step  3: Click  the  item  or  the  type  that  users  want  to  filter  nodes  (files,  folders, 

documents), the filter list result will be displayed on the right panel.

You can click directly on files or a folders's name to view their content and download 

these files .

3.3.6 Preference Setting

This function is used to set up your browsing preferences.

Do as followings:

Step 1: Click the  icon on the right corner of the 'Sites Explorer' portlet. There will 
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be a form to set up your browsing preferences:

1. Enable JCR like structure This option is to display nodes in a document in tree structure 

2. Show sidebar This option is to display a sidebar

3. Show sidebar This option is to display a sidebar

4. Show non document nodes This option is to display nodes that are non – documents

5. Show referenced documents This option is to display referenced documents

6. Show hidden nodes The option is to display hidden nodes 

7. Show items by user in Time 
line View

This option is to display items by a user or not in Timeline view

8. Enable drag and drop This option is to allows taking the “drag and drop” action or not.
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9. Query Type This query type

10. Sort by This condition is used to sort nodes in nodes list. 

11. Order This type of the sorted order.

12. Nodes per page This number of nodes that will be displayed per page

Step 2: After  setting up your browsing preferences, click the  Save  button to set up 

preferences or click the Back button to escape from this form without saving.

3.3.7 Admin 
Admin functions allow you to create  versions, view properties, manage categories, actions, 
import and export nodes.

3.3.7.1  Manage versions

When you update or edit a node, a new content will replace the existing one. By using Manage 
versions function, you can update or edit node but still keep the old versions.

a)  Add versions for node

Step 1: Select a node that you want to add a version from the left or right panel

Step 2: Select the Admin tab to show available administration actions: 

Step 3: Click  the  button. A confirmation message will appear:
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Step 4: Click the Activate button to activate a version for a node

Step 5: Right click a selected node then select Check in from the menu.

Step 6: Click the  again to open the Version Info pop-up:

A node is added a version and it is 'Base version'

Step 7: Right  click  the  selected node and select  Check out to  finish  adding  a 
version for a node:

If node is in the Check In status, you can not take any action like copy/cut, rename , etc. You must 
check out before doing other actions.

If you want to add more versions for a node, right click selected node above and do Check In and 
Check Out
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b)  Add removing labels for versions

✔ To add a label for a version, do as follows:

Step 1: Select a node which is added a version

Step 2: Click the button to open the Version Info form.

Step 3: Click the icon to show the Add label form under the version list:

Step 4: Input a value in the Label field

You can not to use special characters like : @, #, $, etc 

The label name must be different from the existing labels.

Step 5: Click the Save button to accept the inputted label.

✔ To remove a label of a version, do as follows

Step 1: Click the icon to show Remove label form:

Step 2: Click the  icon and select one label you want to remove:
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Illustration 93: The Remove label form
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Step  3: Click the Remove button. The selected label will be deleted.

c)  View versions of nodes

Do the following steps to view a content of a version:

Step 1: Select a node which is added version.

Step 2: Click the  button to open the Version Info form.

Step  3: Click the icon. The node's content of current version will appear:

   

  
If a node is a folder, when click the icon, a pop-up message will appear to inform that the view 

template is not supported for a folder.
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d)  Restore versions of nodes

✔ To restore versions of a node, do as follows:

Step 1: Select a node that has at least 2 versions.

Step 2: Click the button to open the Version Info form:

Step 3: Select a version that you want to make it as a base version.

Step 4: Click the icon. The selected version will become a base version.

e)  Delete versions 

Do the follows:

Step 1: Select a node which has at least 2 versions.

Step 2: Click the to open the Version Info form.

Step 3: Select a version that you want to delete

Step 4: Click  the icon corresponding to the version you want to delete.

Step 5: Click the OK button on the confirmation message to accept deleting or click 

the Cancel button to quit without deleting.
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 You can not delete a base version.

3.3.7.2  Manage Publications

This function is used to manage publications of a node.

Do as follows:

Step 1: Select a node (on the left or right panel) which you want to manage the 

publication.

Step 2: Select the  Admin tab to show some administration actions on the  Action 

bar:

Step 3: Click the button on the Action bar. 

The Manage publication form will be shown immediately: 

This form will display some basic information and the current state of a selected 

node. 
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Step 4: View the content of the node by clicking on corresponding  icon or click 

the icon to restore its version.

Step 5: Select the Publication History tab to view publication's history.

Step 6: Complete this node's publication management by clicking the Save button. 

3.3.7.3  Manage Categories

a)  Add a category for a node

This function is used to add a category for a node. You can only add a category for document 

type.

Do as follows:

Step 1: Select a node that you want to add a category in the left or right panel

Step 2: Select the Admin tab .

Step 3: Click the button to show the Add category form

Step 4: Select the Select category tab to show different categories.
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Step 5: Select a category to add for a node by clicking the  icon.

The selected category will be displayed in the Referenced categories tab:

After being added a category, the node will be included in that category. 

To view this document, do as follows:

• Go to the drive that contain the category you have added to the document. In this 

example, it's acme drive.

• There will be a list of categories  in this drive. 

• Go into the category that you have added to view the document. In this example, 

go to World category.
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Illustration 98: The Referenced categories tab in the Add Category form
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• When you copy and paste a node in a drive, a new node with different name and the same  
content will be stored separately in the database. 

• When you copy and paste a node in a category tree, the system will create a reference to that  
node. It means that the new created node is just a reference to the original one. This's a useful  
feature that help you save the storage:

b)  Delete category 

To delete a category, do as follows:

Step 1: Select a node which is added a category.

Step 2: Click the to open the Add category form. 

Step 3: Select the Referenced categories tab.

Step 4: In the row of a category you want to delete, click the icon. The category 

which is added for a node will be deleted.

3.3.7.4  Manage relations 
This function allows making a relationship from all current nodes to nodes. 

a)  Add relation for a node

Do the following steps to add relations for a node:

Step 1: Select a node that you want to add relations.

Step 2: Select the Admin tab to show some actions.

Step 3: Select button to show the Add Relation form:
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Step 4: Select the Select relation tab to open a document list in different folders

Step  5: Select  relation  nodes  by  clicking  on the icon.  You  only  can  select 

documents.

After the relation documents are selected, it will be listed in the Relation List tab:
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Illustration 100: The  Select relation tab in the Add Relation form
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• You can only add relations for a node to documents, uploaded files.

• You can not add relation for a node to itself.

• You not only see the related document of a node in the Relation List tab but also can see by 
selecting Relation. All related documents of node are displayed here.

b)  Delete relations of node

Do the follows:

Step 1: Select a node that has relation documents

Step 2: Open the Add Relation form by clicking the button

Step 3: Select the Relation List tab to view relations list.

Step 4: In the row of the related document that you want to delete, click the  

icon. 

Step 5: Click the OK button on the confirmation message to accept deleting or click 
the Cancel button to quit. The related document will be deleted from this list.

c)  View Relations of node

You can view all the relation documents of a node by doing following steps:

Step 1: Select a nod that contains relation documents.

Step 2: Click the relation button on the side panel :
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All relations of the selected node will be displayed on the left panel: 

You can click the name of the relations in the list to view.  The corresponding relation will 
be displayed on the right panel.

3.3.7.5  Manage actions

a)  Add an action

This function supports you in adding an action to a node.

Do the follows:

Step 1: Select a node you want to add an action

Step 2: Select the Admin tab.

Step 3: Click the on the Action bar to show the  Manage Actions 

form:

Step 4: Select the Add Actions tab to add an action. The Manage Actions tab will 
be displayed:
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Step 5: Select the type of an action in list by clicking the icon:

Details: 

exo:action the action is not supported

exo:AddMetadataAction to add metadata

exo:autoVersioning   to automatically add version

exo:createRSSFeedAction to create a RSS file

exo:enableVersioning to enable versioning
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exo:getMailAction to get mail

exo:sendMailAction to send an e-mail

exo:taxonomy/Action

exo:transformBinaryTo TextAction to convert the files in “.pdf” or “.doc” format into the text 
file format

Step 6: Fill out required fields in form of the action that you select

Step 7: Click the Save button.

All actions of node are listed in the Available Actions tab

After adding an action to a node, all child nodes of this node will have this action 

in their menu.

   

Only some actions are shown in menu, others will be performed immediately you add that action 
successfully and do a action defined in the 'Lifecycle' field.

Example: If you add an action named 'Send mail' to node A then all child nodes this node will also 
have this action. To check, right click these child nodes to see this action in menu.

b)  View an action 

Do the following steps to view an action:

Step 1: In the Manage Actions form, select the Available Actions tab:

Step 2: Click the   icon corresponding to an action that you want to view.

Information of this action will appear in the Action info tab:

                                 153 of 271

Illustration 102: The Available Actions tab in the Manage Actions form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

c)  Edit an action

Do the following steps to edit an action:

Step 1: In the Manage Actions form, select the Available Actions tab:

Step 2: Click the icon on an action which you want to edit.
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Step 3: Edit the properties in this form.

Step 4: Click the Save button to accept changes.

d) Delete an action

To delete an action, do as follows:

Step 1: In the Manage Actions form, select the Available Actions tab

Step 2: Click the icon corresponding to the action that you want to delete

Step 3: Click the OK button on the confirmation message to accept deleting or click 

the Cancel button to quit.

3.3.7.6  View Node Properties

This function allows you to view all properties and values of a node. In addition, it also allows 
adding more properties for the node. 

Do as follows:

Step 1: Select a node that you want to add more properties for the node.

Step 2: Select the Admin tab to show available actions on the Action bar.
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Illustration 104: The Edit action form
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Step 3: Click the   to show the Properties Management form:

 

Details:

Properties tab displaying all  properties and values of a node.

Add new property tab to add more properties for the node. 

Step 4: To add new properties, you move to the Add new property tab:
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Step 5: Select the namespace for properties

Step 6: Input a new property for the Name field.

Step 7: Select a type for a property:

Step 8: Input a value for this property. Click the icon to add more values for this 

property or click the icon to delete this value.

Step 9: Click the Save button to accept the inputted values or click the Reset button 
to clear inputted values.

After adding a new property for a node, you will be redirected to the Properties tab 
that lists all properties of this node:
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In this tab, you can:

Edit the added property by clicking the  icon in the Action column.

Or delete the added property by clicking the icon.

3.3.7.7  Export nodes

This function is used to export a node into .xml or zip file

Do as follows:

Step 1: Select a node that you want to export.

Step 2: Select the Admin tab.

Step 3: Click  on the Action bar to show the Export Node form:
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Details: 

Path to Export the path of a node to export

Format       the format of the node

Document View each node is a tag and properties of that node are considered to be 
elements of that tag.

System view each node and each property of that node is included in a different tag

Zip a node will be exported in zip type

Step 4: Click the Export button and select the location to save the file

Note: If the current node or some of its child nodes have versions, when export this 

node, the Export Node form appears:

It has more Export version history button. It allows to export the history of current 

node and its children.

3.3.7.8  Import nodes

This function is used to  import the nodes in xml format into JCR Explorer system.

Do the follows:

Step 1: Select the location that you want to import a node.

Step 2: Select the Admin tab.

Step 3: Click the button. The Import Node form will be displayed:
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Step 4: Click the Browse button to select a file you want to import.

Step 5: Click the icon to upload the selected file.

Step 6: Select the UUID behavior from the drop-down list.

Create new: New node will be created with new UUID.

Remove existing:  New node will  be created in  the selected path with the 
UUID of exported node.

Replace existing: Exported node will be replaced by the imported node

Throw Exception: If you select this behavior, there is a message alert that 
you can not import this file.

Step 7: Click the Browse button to select a version history  that you want to import, 

then click the  icon to upload the selected file.

Step 8: Select a format in the Format field.

Step 9: Click the Import button to complete importing a file.

3.3.7.9  Hide/Show content

This function is used to hide or show node

To hide node, do the following steps:

Step 1: Select the node that you want to hide

Step 2: Select the Admin tab
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Illustration 108: The Import Node form
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Step 3: Click  the button on the Action bar to hide a node. A pop-

up message wil appear to inform that you added hidden node successfully! 

Step 4: To show a node, click the button again.

3.3.8 Info

This  tab  provides  actions  that  are  used  to  manage  the  node's  information  such  as  view 
reference, view node type, view properties, etc

3.3.8.1  View Referenced documents

Do the following steps to view referenced documents:

Step 1: Select a node which is added to a category.

Step 2: Select the Info tab to show the View References action.

Step 3: Select a category 

Step 4: Click the  on the Action bar to show the References List 

form. This form will list the the path to each document in the selected category.
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3.3.8.2  View Node Types
This function is used to view detail information of a node.

Do as follows:

Step 1: Select a node that you want to view node types

Step 2: Select the Info tab to show some actions on the Action bar.

Step 3: Click the  to view detail information of the selected none. 

The Node type information form appears: 

Step 4: Click each tab to view information of the node type.

                                 162 of 271Copyright © eXo Platform 2000-2010. All rights reserved.

Illustration 110: The Node Type Information form



eXo Content Manual 3.0
How to use eXo WCM & DMS?

3.3.8.3  View Permissions
This function allows Administrator to establish the right for each node.

a)  View permissions of a node

To view permissions of a node, do as follows:

Step 1: Select a node that you want to view permissions.

Step 2: Select the Info tab to show some actions on Action bar.

Step 3: Click the on the Action bar to show the Permission 

Management form:

In this form, you can view the current permission of the selected node. In addition, you 

also can add rights for another users/ groups if you want.

b)  Add permission for a node

Do the following steps to add permission for a node:

Step 1: Select a node that you want to add permission 

Step 2: Select Info tab to show some actions.
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Illustration 111: The Permission Management  form
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Step 3: Open  Permission Management form by clicking the   

on  the Action bar.

Step 4: Show the Select User Permission form by clicking the  icon next to the 

User Or Group field:

Step 5: Click the icon to select users in the list.

To select users in a specific group, there are two ways:

The 1st way:

1. Enter the group name in the Group field. For an example, you can enter 

a group named  /platform/users and then press Enter key. All users in 

this group are listed in a table below.

2. Click the icon next to the Group field to open the Select Group form 

that is used to select a group with a specific child group:
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3. Select one group on the left panel and a child group on the right panel. All 

users of the selected group are listed in a table.

The 2nd way: 

1. Select information of users in select-box (User Name, First Name, Last 

Name, Email)

2. Put the key word related to the expected user in text box

3. Click the icon to show matched users in the table under.

Step 6: Show the Select membership form by clicking the icon next to the User 

Or Group field. This form allows you to select users with a specific membership of a 

group by selecting a group on the left panel and then select a membership on the 

right.

Step 7: Click the icon to add all users/groups that will have the read permission 

on the node.

Step  8: To  add  more  permissions  such  as:  Add  node  right,  Set  property  right, 

Remove right by checking the check-boxes corresponding to rights that you want to 

add.

Step 9: Click the Save button to accept inputted values. The new added permission 

is listed in the table above.
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c)  Edit permissions of a node

To edit permission of node, do as the following steps:

Step 1: Select a node that you want to edit permission .

Step 2: Select  the Info tab.

Step 3: Click the  to open 'Permission Management' form.

Step 4: In the table of list permission, select the permission of a user or a group

Step 5: Click the icon.

Step 6: Change permissions of that node.

Step 7: Click the Save button to finish editing.

d)  Delete permissions of a node

To delete permissions of a node,do as follows:

Step 1: Select a node that you want to remove permissions.

Step 2: Select the Info tab on the Action bar.

Step 3: Click the button to open 'Permission Management' form.

Step 4: In the row of the permission you want to delete, click the icon.

Step 5: Click the  OK button on the confirmation message to accept removing this 

permission or click the Cancel button to quit without deleting.

3.3.8.4  View Metadata
This function allows you to view or add metadata of a node with the node type is nt:file such as: 

File, Podcast, child node of File Plan and uploaded file.  

Do as follows:

Step 1: Select a nt:file node

Step 2:  Select the Info tab to show some actions.
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Step 3: Click the  to open the View Metadata form:

Step 4: If you want to add metadata for a node, click Add/Edit at the bottom of View 

Metadata form.
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Illustration 113: The View Metadata form
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Step 5: Fill out values in this form that you want to add metadata. Click the icon 

to add more metadata.

Step 6: Click the Save button to accept the inputted values.

3.3.8.5  Show/Hide Relations
This function  is  used to show relation documents of  a  node.  Do as the following steps to 

show/hide relations:

Step 1: Select a node that you want to view relations 

Step 2: Select the Info tab on the Action bar.

Step 3: Click the  to show relations. The relations of the node 

will be displayed in the sidebar:
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Illustration 114: The Add/Edit Properties form
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If the node does not have any relation document, in sidebar, it shows “No related 

document” like:

Step 4: Click the  again to hide relations.

3.3.8.6  Manage Auditing
This function supports you to log property changes of a node. It helps you manage and view 

changes of a node better and effectively.

Do as follow:

Step 1: Select a node (on the left or right panel) that you want to manage auditing.

Step 2: Select the Details view and the Info tab to show some actions on the Action 

bar.

Step 3: Activate the selected node by clicking the  on the Action 

bar. The Activate Auditing form will appear:

Step 4: Click the Activate button to accept activating the selected node.

Step 5: Click the  button again to view auditing information of the 

selected node.
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Illustration 115: The  Activate Auditing form 
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If the selected node has no property change, the  Auditing Information form will 

show:

If the selected node has property changes, the  Auditing Information form will list 

detail changes:

3.3.8.7  Show/Hide Like JCR Structure
This function allows you to view nodes in documents in the form tree structure 

✔ To show like JCR Structure, do as follows:

Step 1: Select a document that you want to show like JCR Structure

Step 2: Select the Info tab.

Step 3: Click the   to show JCR Structure.

Step 4: Click the icon to save. There will be a message that informs:
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✔ To hide JCR Structure:

Step 1: Click the selected document above.

Step 2: Click the again.

                                 171 of 271Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
How to use eXo WCM & DMS?

3.4  Manage Site Content by WebDAV
3.4.1 What is WebDAV?
WebDAV abbreviates for Web – based Distributed Authoring and Versioning which is used to 

publish and manage files and directories on the remote web server. Also, it allows groups of 

users to collaboratively perform these functions on a website. 

WebDAV provides the following features:

• Locking:  This  function  is  to  prevent  the  possibility  of  two  or  more  collaborators 

overwriting their shared files.

• Site  manipulation:  WebDAV  supports  copy  and  move  actions  and  the  creation  of 

'collections' (e.g. File system directories).

• Name space management: This function enables you to copy and move Web pages 

within server's namespace.

3.4.2 Why you should use WebDAV?
You should use WebDAV to manage site content because of the following reasons:

• You can copy/paste a web content, folders/documents/media, etcon your desktop that 

will mirror your host – based site. WebDAV enables people to read and write documents 

over the web.

• Easily, quickly and flexibly manipulate actions on your site without directly accessing a 

site by using browsers. Files can be accessed from anywhere and are stored as in a 

local directories. 

• Specially you don't have to waste time for waiting to upload many pictures/documents 

into your site, you just need to copy those pictures and then paste all of them to the 

folder of the web content that you want.

3.4.3 How to use WebDAV in eXo WCM?
eXo WCM supports two ways to use WebDAV in sites management. Do the following steps:

The 1st way: This way is used when you are on a Window System and your computer 

has to be connected to the Internet or Intranet.

Step 1: Go into  the My Network Places folder on your local computer. You will see all 

shared files and folders:
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To show a site list, do as following steps to use WebDAV:

Click the Add a network place link at the left to open the Add Network Place Wizard 

form:
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Illustration 117: Shared folders in My Network Places

Illustration 118: The Add Network Place Wizard form
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Click the Next button to open a form to choose the location that you want to create the 

network place:

Select  Choose another network location to just create a shortcut. Then you will be 

asked to enter an Internet or a network address to refer.

Enter or copy a link to view a site by WebDAV in a browser into 'Internet or network 

address' field. For an example, the link to view 'acme' site by WebDAV is:

http://localhost:8080/portal/rest/private/jcr/repository/collaboration/sites content/live/acme

Click the  Next button and wait some minutes. A folder named 'acme on localhost ' is 

corresponding to the inputted  link will  appear  in  the  My Network Places folder like 

below. In WebDAV, each site will be a folder.
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Go into the folder corresponding to the site which you want to take actions on it.

The 2nd way:

Step 1: Using IE (Internet Explorer) browser to access http://localhost:8080/portal 

Step 2: Select the following path: Group→ Sites Explorer page on the Administration 

bar.

Step 3: Go to Drive → Select Sites Management drive. 
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Illustration 120: My Network Places folder
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You will see all sites listed on the left panel like illustration below. 

Step 4: Right-click a site that you want to view by WebDAV and select the Download 

and Allow Edition item in the menu:
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The selected site will be viewed by WebDAV like the illustration below. With this view, 

you can access documents in directories/folders linked to a web server. 
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Illustration 121: The Default folders of a site in WebDAV view
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3.4.4Actions
Access  into  a  site  by  WebDAV  view,  you  also  see  all  default  folders of  a  site  normally. 
Manipulating on WebDAV is like manipulating on folders. It means that you also can copy/paste, 
list folders, rename, etcas for system directories.

3.4.4.1  Add a new web content into a specific site

This function is used to copy a web content (such as a .html file or a web content) from your 
local computer to 'web content' folder of a site.

Do the following steps:

Step 1:  Access into a site by WebDAV and then go to web content folder of this site.

Step 2: Copy a web content file on your local computer and then paste to this folder. 
The  copied  file  will  be  converted  to  web  content  automatically  that  is  viewed  by 
WebDAV. It means that copied web content is also a folder containing default folders: 
CSS, documents, js, media.

After adding a new web content successfully, you can view it as a folder by WebDAV view or 
view it as a web site by using a browser.

3.4.4.2  Delete a web content

This function supports webmasters to delete one or more web content at once.

Step 1: Go into the folder that contains web content that you want to delete.

Step 2: Then right-click a web content or more web content (keep Ctrl and select web 
content to select more web content at once) and select the  Delete in the menu like 
deleting system folders and the selected folders will be removed from your site.
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3.5  How to publish a site?
Besides publishing a web content in Sites Explorer, you also may use this function to publish a 

site to everyone or only some groups/users that you want. Use Content List Viewer – CLV to 

publish a web content.

CLV allows you to directly publish multiple content on the Overview page.

✔ To publish a site, do as follows:

Step 1: Turn on the Edit mode. 

Step 2: Clicking on the corresponding edit icon on the element you want to edit. 

The Content list viewer configuration of that element will appear:
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Details:

Mode This mode is to select web content for list viewer. There are two modes:

• By Folder:  This mode allows you to select a content folder in the 
Folder path field. 

• By Content: This mode allows you to select  by  the content in a 
specific folder in Folder path field.

Folder path The path to a location of a folder that contains the content. 

Order by The field is selected to sort content in the list viewer. You can sort content 
by Title, Date created or Date modified in ascending or descending order.

Header The title for all content that are listed in List Viewer.

Viewer template The template is used to view content list.

Paginator template The template is used to view each content in list.

Items per page The number of items will be displayed per page.

Show image The option is to show or hide the illustration of each published web content/ 
document.

Show summary The option is  to show or hide the summary of each web content/document.
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Show header The option is whether to show a header or not.

Show refresh 
button

The option is whether to show the refresh button at the left bottom of this 
page or not.

Show title The option is to show or hide title of each published web content/document.

Show date created The option is to show or hide the created date of each published web 
content/document.

Show link The option is to show or hide the link of web content /document.

Read more The option is to show or hide the Read more to read all the content of a web 
content/document.

Step 3: Browse the documents/ web content of an available site by clicking the icon 

next to the folder path field.

Step 4:

• If you select the By folder mode: 

Select an available site on the left  and then select a folder that contains content 
(documents/web content) on the right by clicking on it.
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Illustration 123: The folder browser to view possible folders that can be selected
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• If you select the By content mode: 

Select an available folder from the left panel, all content in this folder will be listed on the 
right panel. 

Step 5: Select content by clicking the content in the  Name column and a message 
informs that you have successfully  added it  in List Content. The selected content is 
listed in List Content.

Step 6: Click the Save button to accept publishing content of the selected folders.

After publishing content successfully, the content of selected folder will be displayed in 
the Overview page. 

  

If you are turning on the EDIT mode, you will see all the DRAFT and PUBLICATION versions of the 
Content List Viewer, thus you can edit a draft version by clicking on the Edit.

But if the LIVE mode is turned off, only the PUBLICATION versions are displayed.
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3.6  Newsletters 
eXo  WCM provides  a  newsletter  service  aiming  at  helping  users  quickly  get  the  updated 
newsletters from a website.

3.6.1 Newsletter Viewer
Users instantly get newsletters from your email in order to update the newest information about 
categories and subscriptions that users frequently care about.

Follow these steps to subscribe to newsletters from exoservice:

Step 1: Go to Newsletters on the navigation bar. The Newsletters page will appear:
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Step 2: Enter your email address for the Your Email field.

Step 3:  Select the check box corresponding to the subscription that you want to get 
newsletters.

Step  4:  Click  the  Subscribe button.  A message  will  inform  that  you  have  just 
subscribed to the selected newsletter.

Step  5: Click  the  OK button  in  the  confirmation  message.   You  can  reselect  the 
subscription that you want or don't want to receive newsletters by re-selecting the check 
box in the Check to subscribe column.
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Step 6: Click the Change your subscriptions button to update your changes.

Step 7:  Click the  Forget this email button in case you do want to unsubscribe from 
newsletters.

3.6.2 Newsletter Manager
eXo WCM facilitates administrators to easily and quickly manage and control newsletters by 
following the steps below: 

Go  to  Groups →  Newsletter  Manager  on  the  Administration  bar.  The  Newsletter 
Manager page will appear:

3.6.2.1  Category
Administrators easily add new categories. 

a)  Add a new category

Step 1: Click on the action bar of the Newsletter Manager Page. The 
Category form will appear:
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Illustration 124: The Newsletter Manager Page
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Details:

Name The name of a category. This field is required.

Title The title of a category. This field is required.

Description The brief description about the category. This field isn't required

Moderator Allows an administrator to select which memberships what group 
can manage this category.

Save To accept adding a new category.

Cancel Allows  quitting the Category form without adding category.

Step 2: Input values for fields. 

Select a moderator for a category by clicking the icon next to the Moderator field to 

select an user. The User selector form will appear:
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Illustration 125: The Category form
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Click the  icon to select a user in the list.

Click the  icon to select users in a specific group. The Group selector will appear:

Select  one group in  the left  panel  and select  a membership in  the right  panel.  The 
membership and group that you have just selected will be displayed on the Moderator 
field.

After adding new categories, they will be added in the list of the categories.

Step  3: Click   the  category  that  you  want  to  manage  (for  example:  the  Fashion 
category).
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Illustration 126: The User selector form

Illustration 127: The Group selector form
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Here, you can create new subscriptions or newsletters for this category. 

Step 4: Click the Administration button to open the menu which lists all actions that an 
administrator can take on this category.

b)  Edit a Category

To edit a category, follow these steps:

Step 1: Click the Administration button → Edit Category . 

The Category form will appear:
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Details:

Name The name of the category. This field can not be changed

Title The title of the category. This field can be changed.

Description The brief description about the category. This field can be changed.

Moderator Allows an administrator to select which memberships in what group can 
manage this category by selecting membership and group. This field 
cannot be changed. 

Save To save editing a new category.

Cancel Allows quitting the Category form without editing a new category.

Step 2: Change the values in the Title and Description fields if you want.

Step 3: Click the  Save button to save all  the changes or the  Cancel  button to quit 
without saving any change.

c)  Delete a Category

Step 1: Click Delete Category in the menu. The confirmation message will appear:

Step 2: Click the OK button to accept deleting this category or the Cancel button to quit 
without deleting.

d)  Manage Users

Administrator easily manage users with some actions such as: edit, ban, remove ban or delete 
users.

Step 1: Click the Administration button → Manage Users in the menu. The Manager 
Users form will appear:
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Details:

Email The email address of a user that subscript this subscription.

Banned There are 2 values: false means a user is allowed to get emails or true means a 
user isn't allowed to get

To edit this user.

To ban a user to get emails.

To unban a user to get emails.

To delete a user that corresponds to the trash can icon you  have just 
clicked.

                                     

Step 2: Click the Close button to close this form.

3.6.2.2  Subscription

In each category, an administrator can add more new subscriptions for that category. There are 
two ways to add a subscription for a category:

The 1st way:

Click New Subscription on the action bar.
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 The Subscription form will appear:

Details:

Category The category that contains this subscription.

Name The name of the subscription. This field is required.

Title The title of the subscription. This field is required.

Description The brief description about the subscription. This field is not required.

Redactor Allows an administrator to select which memberships in what group can manage 
this subscription by selecting membership and group. This field cannot be 
changed.
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Step 1: Click  to select the category for which you want to create a subscription:

Step 2: Input values in the fields in this form.

Step 3: Click the Save button to accept creating a new subscription or the Cancel button 
to quit without creating a new subscription.

The 2nd way: 

Click directly the category that you want to create a subscription

Click New Subscription on the action bar . The Subscription form will appear and do 

the same as the 1st way.
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In addition, an administrator can create newsletters for each subscription, click here to 
see how to create a newsletter for a subscription.

After  creating  newsletters  for  a  subscription,  the  administrator  can  manage  these 
newsletters by opening, editing, deleting or converting as a template for using later.

Details:

Shoes The name of the subscription.

Fashion shoes The brief description about the subscription.

Letter List all letters of this subscription.

Date The date and time when creating this letter.

Status There are 3 types of status: draft, awaiting and sent.

Moderation This button allows you to take actions on a newsletter that you select
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3.6.2.3 Open a Newsletter
Administration can easily view the content of a newsletter. Do the following steps:

Step 1: Choose a specific subscription in a catagory by left-clicking on it or checking in 
the checkbox  → choose the administration button → choose Open item: 

Step 2: Select the newsletter that you want to open by left-clicking on it or selecting the 
checkbox. 

Step 3: Click the  button → Open in the menu. 

The Content of View Newsletter form will be displayed:
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Step 4: Click the Close button to close this form.

3.6.2.4  Edit a Newsletter
Do the following to edit a newsletter: 

Step 1: In a specific subscription, select the newsletter that you want to edit by selecting 

the  checkbox.

Step 2: Click the   button → choose Edit in the menu. 

The Newsletter entry form will appear:
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Step 3: Change the values in the fields that you want to edit:  Template,  Send date, 
Category, Subscription.

Step 4: Click the Update a Newsletter's info button.

Step 5: Change the values in the fields: Title and Main content .

Step 6: Click the Save button to save as draft or click the Send button. 

3.6.2.5  Delete a Newsletter
Administrator can delete obsolete newsletters by following:

Step 1: In a specific  subscription,   select  the newsletter  that  you want to delete by 

selecting the  checkbox
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Step 2: Click the button → click Delete in the menu.

 The confirmation message will be displayed:

Step 3: Click the OK button to accept deleting this newsletter or the Cancel button to 

quit without deleting.

3.6.2.6  Convert as Template

Administrator can reuse the template of the frequently used newsletter template by:

Step 1: Select the newsletter that you want to make it as a template.

Step 2: Click the button → Convert as Template in the menu. The next 

time when you create a newsletter, this template will be listed in the Template field in 
the Newsletter entry form.

3.6.2.7  Newsletters

Each subscription consists of many newsletters. eXo WCM helps you easily create newsletters 
by following these steps:

Step 1:  Go to Groups →  Newsletter Manager on the Administration bar.  The eXo 
Newsletter appears.

Step 2: Click on the action bar. The Newsletter entry form will appear:
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Details:

Template The template that you select for your newsletter form.

Send date The date and time when you want to send this newsletter.

Category The category contains this newsletter.

Subscription The subscription contains this newsletter.

Update sending 
parameters

This button allows you to update information about this newsletter.

Step 3: Click to select the template for a newsletter.

Step 4: Click the Send Date field. The calendar will appear to allow you to choose the 
date and time when you want to send this newsletter.
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Step 5: Click in the category field to select the category and the subscription in list.

Step 6: Click the Update sending parameters button to update information about this 
newsletter.  A  message  pops  up  and  informs  that  you  have  updated  information 
successfully.

Step 7: Input a title of a newsletter in the Title field.

Step 8: Create a content for a newsletter by inputting information in the Main content 
textbox

Step 9: Click the Save button to save this newsletter as draft or click the Send button to 
send this newsletter .

Step 10: Contact Us on the navigation bar or go to Site → Acme → Contact Us

The Contact Us page will appear:
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Details:

Select a recipient the recipient who will receive a message

Your name the name of a person who leaves a message

Your Address the address of a person who leaves a message

Your Email Address the email address of a person who leaves a message

Your Phone Number the phone number of a person who leaves a message

Your message write a message that you want to leave

Step 11: Select a recipient and enter values in this form.

Step 12: Click the Save button to save a message.
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3.7  Fast Content Creator
The eXo WCM provides users with the Fast Content Creator portlet that allows users to create 
document content quickly. The Fast Content Creator portlet is applied in the Contact Us on the 
navigation bar:

Step 1: Go to Contact Us on the navigation bar or go to Site → Acme → Contact Us.

The Contact Us page will appear:

Details:

Select a recipient To choose people who will receive the message.

Your Name To type the name of person who leaves a message.

Your Address To type the address of person who leaves a message.

Your Email Address To enter the email address of person who leaves a message.

Your Phone Number To enter the phone number of person who leaves a message.

Your Message To write a message that you want to leave.

Step 2: Select a recipient and enter values in this form.

Step 3: Click the Save button to save a message.
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3.7.1 Edit Mode 
Users can edit templates, take actions and save locations for the documents in the Contact Us 
portlet.

Step 1: Go to Contact Us on the navigation bar or go to Site → Acme → Contact Us.

Step 2: Click Site Editor on the administration bar → Edit Page.The Page Editor will 
be displayed.

Step 3:  Click the edit icon to open the Edit Mode tab in the Contact Us portlet.

The Edit Mode tab is displayed like the following illustration: 
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 Details:

Location to save To select the location for saving documents or messages.

Select Template To choose available templates for documents. There are 
corresponding fields to each template.

Custom save button To change the label for the save button.

Custom save message To show the message that informs you have just saved a 
document.

Redirect To allow users to redirect the path in the Redirect path field. 

Redirect path The show a path that a user will be directed to after he/she clicks 
the OK button in the confirmation message.

Actions To add another actions to documents.

Step 4: Click the icon to search for the location for saving documents. The Select 
location form will appear:
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Step 5: Select the parent node on the left panel and click the icon in the  Action 
column to choose the child node on the right panel. After being selected, this location 
will be displayed on the Location to save field. Created documents will be saved in this 
location.

Step  6: Select  a  template  for  documents  by clicking   . 

Step 7: Change the label for the Save button and the message content after clicking the 
Save button.

Step  8: Select  the  Redirect  checkbox  if  users  want  to  redirect  to  the  path  in  the 
Redirect path field after clicking the OK button in the save message.

Step 9: Click the Save button to save all changes of editing properties for documents 
that users will create in the Contact Us Portlet.
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3.8  Form Generator
The Form Generator portlet allows users to create and to edit template of document types. 
Documents are stored in the so-called node; therefore, the term “node” and node types are 
often applied.

Step  1: Go  to Group  → Form Generator on  the  Administration bar.  The  Form 

Generator will appear like the illustration below:

Step 2: Input the node name in the Name field. (*Required).

Step 3: Input the brief description about the node.
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Step 4: Click  the  Form builder  tab that  allows users to  set  properties for  a node. 
Available components are displayed on the left panel. 

Step 5: Click the desired components on the left panel. The selected components will 
be displayed on the right panel.

Step 6: Click the icon corresponding to the component to move this component up or 
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the icon  to move the component down.

Step 7: Click the icon that corresponds to the component to edit properties of that 
component. The form to edit properties appears like the illustration below:

Details:

Field Label To enter the field label.

Width

To enter the field width. If the checkbox in  is 

marked, the star will appear beside the text box, indicating that it is 
required to input values for the text box.

Height To enter the field height.

Default Value To display the default value.

Guidelines for User To give instructions about this component.

To delete this component click the trash icon that corresponds to the component.

Step 7: Click the Save Form button to save the form that you have created for nodes.

Step 8: Click the Save button to accept creating a new node or the Reset button to edit 
this node again before saving.
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3.9  Categories
When  implementing  the  Category,  users  will  actually  enjoy  nice  features  via  the  Category 
model. Thanks to the symbolic link, no matter where the object physically resides, the database 
can retrieve it. In addition, the relations amongst shortcuts can be managed. Now, you can view 
documents or web content in the Parameterized Content List Viewer in such an easy way. 

Step 1: Go to News on the navigation bar.

The left panel: lists all the sub-categories containing documents or web content.

The right panel: shows the documents or web content that you have selected on the left 

panel.

Step 2: Select a category that you want to view on the left, it will be shown on the right 

(only documents or web content published are shown).

Step 3: Click the title of document or web content to view the whole. 
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3.9.1 The Edit Mode of Category Navigation portlet
Administrators can edit the Category Navigation portlet by following these steps:

Step 1: Go to News →Turn on the Edit mode → Click the edit icon on the 
Category panel. 

The Category List Configuration form will appear like the illustration below: 

Or, go to Group → Administration → Page Management on the Administration bar. 
The Manage Pages form appears like the illustration below:
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Step  2: Click  the  icon that  corresponds  to  the  Category  navigation portlet  for 

editing this portlet. 

The Edit Mode will be displayed:
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Details:

Repository The location used for storing documents or web content.

Title The subject that will be displayed in the View mode.

Tree name The available types of taxonomy tree.

Tree Viewer Template The template of the category navigation.

Target Path The path that will display documents or web content. 

Step 4: Click to select the repository for documents in the Repository field.

Step 5: Input the category name in the Title field.

Step 6: Select the taxonomy tree for a category.

Step 7: Select the template for displaying categories.

Step 8: Click the icon to select the target path. The Page selector form will appear:

Step 9: Click to select the navigation on the left panel. The corresponding pages 

will be displayed on the left panel and the corresponding paths will be displayed on the 
right panel.
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Step 10: Click the icon to select the path. This path will be displayed in the Target 

Path field.

Step 11:  Click the  Save button to accept  saving the configuration for the  Category 
Navigation portlet.

3.9.2 The Edit Mode in Parameterized Content List Viewer
Users are entitled to edit the settings in the Parameterized Content List Viewer portlet.

Step 1: Turn on the Edit mode of a site.

Step 2: Click the edit icon ( at the upper right corner of this panel, the edit 

form of Parameterized Content List Viewer will be displayed:
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Details:

Order by To choose types of order priority for documents or web-content. The 
“descendant” means documents or web-content are arranged according to 
the increasing order; meanwhile the "ascendant” means documents or web-
content are arranged according to the decreasing order.

Header To enter the topic containing documents or web-content. You can use the 
default header to let the portlet define the Header from the category URI.

Viewer template To choose the template in which documents or web-content will be displayed 
for viewing.

Paginator 
template

To choose the template in which documents or web-content will be arranged.

Items per page To enter a number of documents or web-content that will be displayed per 
page.

Show title To allow showing titles of documents or web-content.
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Show header To allow showing headers of documents or web-content.

Show refresh 
button:

To allow showing the refresh button.

Show illustration To allow showing images of documents or web-content.

Show date 
created

To allow showing the date when documents or web-content are created.

Show read more To allow showing more documents or web-content.

Show summary To allow showing summaries of documents or web-content.

Show link To allow showing the title of document or web-content.

Show RSS link To allow showing the RSS link containing documents or web-content.

Target page The page that users want to link the content to.

Step 3:  Select the type and the order displaying document content or web content by 

selecting the Order by field, and Descendant or Ascendant checkbox.

Step 4: Click to select the template for Viewer and Paginator.

Step 5: Input the number of items that will be displayed per page in this portlet.

Step 6: Select/unselect  the checkboxes,  including  Show title,  Show header,  Show 

Refresh buttons, etc.

Step 7: Click the magnifying magnifier icon to select the target page. The  Page 

selector form will appear:
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Click to select the navigation, the corresponding pages will be displayed on the left 

panel and the corresponding path will be displayed on the right panel.

Click that corresponds to the selected path on the right panel to select the path. 

The selected path  will be displayed in the Target Path field.

Step 8: Click the  Save button to accept changes or the Cancel button to quit without 

saving.
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4  eXo WCM Administration
4.1  Access eXo WCM Administration
This page is used to manage all workspaces, drives, node types, metadata, templates, queries, 
etc. Only administrator like ''root” can access the WCM Administration.

Click the Sites Administration on the  Group bar:

The Sites Administration will appear like the following illustration: 

This section includes:

• Ontologies: includes Manage Folksonomy and Manage Taxonomies.

• Content Presentation: includes Manage Template, Manage Metadata, Manage 
Views, Manage Drive.

• Types of Content: includes Namespace Registry, Manage Node Type.

• Advanced Configuration: includes Manage Queries, Manage Scripts,  Create 
an Action Type.
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4.2  Ontology
4.2.1 Folksonomy Management
The Folksonomy allows you to manage tag styles. The tag style will be changed depending on 

the number of documents in a tag.

Go to Sites Administration → Ontologies→ Manage Folksonomy. 

4.2.1.1  Edit 

            Tag manager tab:

To edit existing tags, do as follows:

Step 1: Click the icon that corresponds to the tag name which you want to edit in the 

Action column to edit the tag style configuration. The Edit tag style configuration form 
will appear:
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Details:

Style name To give the tag name. (*Required).

Document Range To give the number of documents assigned to the same tag. 
(*Required).

Html style To include font-size, font-weight, color, font-family, text-decoration. 
(*Required).

Step 2: Change values for fields:  Style name,  Document range,  Html style that you 
want to edit.

Step 3: Click the Update button to save new changes or the Cancel button to quit this 
form without changing.

  

   

• You can not edit the style name.

• The format of valid range must be: a..b with 'a', 'b' are positive integers. You can use * instead of 'b'  
to indicate it is unlimited. 

• The 'Html style' text box can not be empty: you can change values of font-size, font–weight, color,  
font-family, text-decoration. 

4.2.1.2  Delete a tag style

An administrator can delete a tag style by clicking the trash icon that corresponds to the 

tag style which an administrator wants to delete. There will be a message which confirms the 

deletion:

Click the  OK button to accept deleting or the  Cancel  button to quit without deleting the tag 

style.
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4.2.1.3  Add a tag style
Furthermore, an administrator can add a new tag style as follows:

Step 1: Click the Add style button. The Edit tag style configuration form will appear:

Step 2: Input values for fields:  Style name,  Document range and  Html style,  all of 

which are required.

Step 3: Click the Update button to accept adding a new tag style or the Cancel button 

to quit without adding a new tag style.

 The  Tag permission manager tab: helps administrator set permissions regarding to 

editing and deleting public tags. 
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Step 4: Click the icon to select memberships in order to add a permission for those 

memberships. The Select membership form will appear: 

Step 5: Select a group on the left and the corresponding membership on the right. The 

selected membership will appear in the Memberships field:

Step  6: Click  the  Save button  to  accept  adding  a  permission  for  the  selected 

membership of the selected group. The selected membership that has just been added 

a permission will be listed in the Memberships column.
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An  administrator  can  also  delete  memberships  that  have  been  set  permissions  by 
clicking  the  Delete icon  relevant  to  that  membership.  A confirmation  message  will 
appear:

Step 7: Click the  OK button to accept deleting or the  Cancel button to quit this form 

without deleting.

4.2.2  Manage Taxonomy Trees 
A  Taxonomy may be understood as a classification practice and science. It  is  used to sort 

documents,  aiming  at  facilitating  searches.  The  Taxonomy  management  includes  adding, 

editing and deleting a taxonomy tree.

Go to Sites Administration → Ontologies→ Manage Taxonomy Trees.
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4.2.2.1  Add a taxonomy tree
Do the following:

Step  1: Click  the  Add Taxonomy Tree button  to  add  a  new  taxonomy.  The  Add 

taxonomy tree form will appear:

Step 2: Enter the taxonomy tree name in the Name field. (*Required).

Step 3: Select the workspace that you want to work with.

Step 4: Select the home path by clicking the icon . The Select home path form will 

appear:
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Illustration 142: The Add taxonomy tree form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
eXo WCM Administration

Click the icon  if you want to select the root path or click the icon to go to the up 

level path. Click the icon  to expand the folder.

Click the icon  corresponding to the path that you want to select as a home path.

Click the  Reset button if you want to reset values that have just been selected or the 
Next button to select permissions for a taxonomy tree.

                                      223 of 271

Illustration 143: The Select home path form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
eXo WCM Administration

Step 7: Click the icon  to select a user or the icon  to select memberships or the 

icon  to select  everyone in order to set permissions. The user or membership that 
you have just selected will be displayed in the User or Group field.

Then, check at least one of these below options to set rights for the selected user or 
membership:

Read Right: The option is to select the read right or not.

Add Node Right: The option is to select the Add Node right or not.

Set Property Right: The option is to select the Set Property Right or not.

Remove Right: The option is to select the Remove right or not.

Step 8: Click the Save button to save all values or the Reset button to change values 
that have just been set. After clicking the Save button, click the Next button to go to the 
next step.
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Step  9: Enter  the  name  for  an  action  of  the  taxonomy  tree  in  the Name  field. 
(*Required).

Step 10: Select values for  Lifecycle,  NodeTypes,  Target workspace,  Target path, 
Affected Node Types. (*Required).

Step 11: Click the Save button to save all values and click the Next button to go to the 
next step.

     

Do not input some special characters in the 'Name' field like: !,@,#,$,%,&,*,(,).

Do not add a taxonomy which has the same name and level with existing taxonomies in a node.

The taxonomy name must contain less than 30 characters.

4.2.2.2  Edit a Taxonomy Tree
Do the following:

Step 1: Click the edit icon ( )  that corresponds to the taxonomy tree which you want 

to edit.
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Step 2: Click the  icon  to add more taxonomy trees. The Edit taxonomy tree will 

appear:

Step 3: Enter a taxonomy name in the Taxonomy name field. (*Required).

Step 4: Click the Save button to save a taxonomy name.

Step 5: Click the Previous button to return to the previous steps.

Step 6: Click the Save button to save all changes and the Previous or Next button if 

you want to edit more.

You can delete a taxonomy by clicking the trash icon  corresponding to the taxonomy that you want 

to delete. Click the OK button on the confirmation message to accept deleting this taxonomy or click 
Cancel button to discard this action.

You can not delete taxonomies that have been referenced.
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4.3  Content Presentation Management
4.3.1 Manage A Template
To create a node in WCM, this node must set its properties. Thus, each node needs to have a 

form  for  entering  data  for  their  properties  (called  the  dialog  template),  and  displaying  the 

existing values (called the view template). The template management allows users to view, 

delete and modify the predefined templates or to add a new template.

Go to the Sites Administration → Content Presentation → Manage Template

4.3.1.1 Add a new template
The function is used to add a new template. Do the following:

Step 1: Click the  Add  button in the  Manage Templates form to open the  Template 

Form:
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(*): Required.

Step 2: Select the template type that you want to add by clicking in the Name field: 

Step 3:  Add a label for this template in the Label field. 

Step 4: Check /uncheck 'is Document Template' if this template is for document or not.

Step  5:  Show  the  Select  Permission form  by  clicking  the  icon next  to  the 

'Permission' field:
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Step 6: Select a group on the left panel and a specific membership that you want to 

share this template. 

Step 7: Select the Dialog tab and enter value in Dialog content field..

Step 8: Select the View tab and enter values in the View content field. 
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Illustration 147: The Dialog tab
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Step 9: Select the CSS tab and enter values into the skin field. (Not required).

Step 10: Click the Save button to accept adding a new template.
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Illustration 148:  The View tab

Illustration 149: The CSS tab
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4.3.1.2  Edit a Template
✔ To edit a template as follows:

Step 1: Click the  iconin the Action column corresponding to the template that you 

want to edit.

The View & Edit Template form will appear like:

Step 2: In the Template tab, edit the properties that you want.

Step 3:  In the Dialog tab, you can add dialogs, edit or delete them.

 

• You can not edit the template name.

• You can not check/uncheck in 'Is Document Template' checkbox.

• 'Label' field can be blank.
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✔ To Add a dialog do as follows:

Step 1: Input content for this dialog in the 'Content'  field. Input name for this dialog. 

(*Required).

Step 2:  Select permissions for a group that can use this dialog. (*Required).

✔ To edit a dialog do as follows:

Step 1: Click the  icon on a dialog you want to edit.

Step 2: Edit the current dialog's properties.

Step 3: Click the Save button to accept all changes of the dialog.

  

 

You can not change the dialog name.

If you select the 'is Enable Version' check-box, this dialog will automatically increase to 1 version after 
you click Save. It is displayed at ' Version' column in Dialog tab.

If the dialog has at least 2 versions, in the Dialog tab, it will display Restore button that allows restoring 
the dialog version.
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✔ To delete a dialog, do as follows:

Step 1: Click the  icon corresponding to the dialog that you want to delete.

Step 2:  Click the OK button on the confirmation message to accept deleting or click  the 
Cancel button to discard this action.

Step 3:  In the View tab, you can add views, edit or delete them.

    

You can not delete the default dialog.
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✔ To add a view, do as follows:

(*) required

Step 1: Select the View tab. Enter content for content filed. 

Step 2: Input name for this view. (*Required).

Step 3: Select permission for the group that can use this view. 

✔ To edit a view, do as follows:

Step 1: Click the icon corresponding to the view that you want to edit.

Step 2: Edit the properties of the current view.

Step 3: Click the Save button to accept all changes of the view.

You can not change the view name.

If you click 'is Enable Version' checkbox, this view automatically increases to 1 version after you 
click Save button. It is displayed at ' version' column in the View tab.

If the dialog has at least 2 versions, in the View tab, it displays the Restore button that allows 
restoring the view version.

✔ To delete a view do as follows:

Step 1: Click the trash icon  corresponding to the view you want to delete.

Step 2: Click the  OK  button on the confirmation message to accept deleting or click 
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Cancel button to discard this action.

Step 3: Click the Save button to accept all changes.

 You can not delete  the default view.

✔ To add a CSS, do as follows:

Step 1: Click the CSS tab, enter content in the Content field. (*Required). 

Step 2: Input a name in the Name field.  (*Required).

Step 3: Select permissions for a group that can use this dialog. (*Required). 

4.3.1.3  Delete a Template
Do the following:

Step 1: Click the trash icon  corresponding to the template that you want to delete.

Step 2: Click the OK button to accept deleting this template or click the Cancel button to 

discard this action.

4.3.2 Metadata Management
Metadata have multiple definitions, the most brief one is "data about data." Generally, it may be 

understood as information that describes, or supplements the central data.

The metadata management allow managing nodes in the metadata format in the WCM system. 

The metadata may be considered as information used to describe the data. When data are 

provided to the end users, the metadata allow users to understand about information in more 

details. All metadata nodes can combine with other nodes to create a new node (add mix).

This section includes Viewing Metadata, Editing and Deleting functions.

Go to Sites Administration → Content Presentation → Manage Metadata

4.3.2.1  View Metadata
Do the following:

Step 1: Click the  icon corresponding to the metadata that you want to view.

The Metadata information form will appear:
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4.3.2.2 Edit Metadata
Do the following:

Step 1: Click the icon  corresponding to the metadata that you want to edit.

The Edit Metadata's Template form will appear:

Step 2: Change  properties  of  the  edited  metadata.  Note  that  you  can  not  edit  the 

metadata name.

Step 3: Click the Apply button to finish all changes.
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Illustration 152: The Metadata information form
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4.3.2.3  Delete Metadata
Do the following:

Step 1: Click the trash icon corresponding to the metadata that you want to delete. 

A confirmation message will appear.

Step 2: Click the OK button to accept deleting this template or click the Cancel button to 

discard this action.

4.3.3 Manage Views
The function Manage View is used to control view ways of a user. It  has 3 tabs: View, WCM 

Templates and BC Templates tabs.

Go to Sites Administration → Content Presentation → Manage View
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4.3.3.1 View

a)  Add a new view

The function is used to add a new view. Do the following:

Step 1: Click the Add View at the bottom of the View tab to show the Add View form 

like below:

Step 2: Enter the new view name in the Name field. (*Required).

   The name must be unique.

The name must not contain special characters like !,@,#,$,%,&,*,(,).

Step 3: Click the icon to set permissions in this view. The Select Permission form 

will appear:
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Step 4: Select a group in the list on the left panel and a specific membership on the right panel. The 

selected users will have access permissions to this view.

Step 5: Click the icon in the Templates field and select a template for this view.

b)  Preview a view 

Do the following: 

Step 1: Click the icon in the  Action column corresponding to the view which you 

want to preview. 

The View form will appear:

Step 2: Click the Close button to exit the View form.
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c)  Edit a view

Do as follows:

Step 1: Click the iconcorresponding to the view that you want to edit. The Edit View 

form appears:

Step 2: In the Edit View form, edit the properties of the current view.

You can not edit the view name.

If you check the 'Enable version' option, this view automatically increases to 1 version after you click 
Save button. It is displayed at the 'Base version' column in the View tab.

If the view has at least 2 versions, in the 'Edit ECM Template' form, it displays Restore button that allows 
restoring versions of the template.

Step 3: Click the Add Tab button to open the Tab Form tab to add more tabs. 

After that, click the  Add Tab button to add a new tab or the  Reset  button to change 

values for these fields and click the Back button to return to the View Form tab in the 

Edit View form.

Step 4: Click  the  Save button to accept  all  changes or  click  Cancel button to quit 

without changes.
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d)  Delete a view

Do the following:

Step 1: Click the   icon that corresponds to the view which you want to delete. A 

confirmation message will appear.

Step 2: Click the OK button to accept deleting or click the Cancel button to discard this 

action.

You can not delete a view which is in use.

4.3.3.2 ECM Templates

a)  Add a new ECM Template

Do as follows:
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Step 1: Select the ECM Templates tab.

Step 2: Click the Add button to open the Add ECM Template form:

(*):required

Step 3: Input content of the template in the Content field. 

Step 4: Input a name for the template in the Name field.

Step 5: Select a type for the template in the 'Template Type' field. 

Step 6: Click the Save button to accept adding a new template or click the Reset button 

to change values or Cancel to quit without any changes. 

     The name of templates must be unique.

The name must not contain special characters like !,@,#,$,%,&,*,(,).

b)  Edit a template

Do as follows:

Step 1: Click the  icon  that corresponds to the template you want to edit.

The Edit ECM Template form will appear:
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Step 2: Change the current template's properties.

Step 3: Click  the  Save button to accept  all  changes,  or  Cancel  to quit  without  any 

changes. 

   

You can not edit the template name.

If you tick the 'Enable version' checkbox, this template will automatically increase to 1 version after you 
click Save button. It is displayed at the 'Base version' column in ECM Template tab.

If the template has at least 2 versions, in the 'Edit ECMTemplate' form, it displays the Restore button 
that allows restoring the template version.

c)  Delete a template

Do as follows:

Step  1: Click  the   icon  corresponding  to  the  template  you  want  to  edit.  A 

confirmation message will appear.

Step 2: Click the OK button to accept deleting this template or click the Cancel button to 

discard this action.
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4.3.3.3 BC Templates

a) Add a new BC Template

Do as follows:

Step 1: Click the Add button to open the Add BC Template form:
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Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
eXo WCM Administration

Step 2: Input the content for the template in the Content textbox. (*Required).

Step 3: Input the name for the template in the Name field. (*Required).

Step 4: Select the template type by clicking the   icon in the Template Type field.

Step 5: Click the Save button to complete adding a new template.

The name must be unique.

The name must not contain special case like !,@,#,$,%,&,*,(,).

b)  Edit a template

Do as follows:

Step 1: Click the  icon  on a template that you want to edit.

The Edit BC Template form will appear:
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Step 2: Edit the properties of the current BC Template.

Step 3: Click the Save button to accept all changes.

 

You can not edit the template name.

You can not edit the template type.

If you click the 'Enable Version' checkbox, this template will automatically increase to 1 version after you 
click Save button. It is displayed at the 'Base version' column in the 'BCTemplate tab.

If the template has at least 2 versions, in the Edit BC Template form, it displays the Restore button that  
allows restoring the template version.

c)  Delete a template

Do as follows:

Step  1: Click  the   icon  corresponding  to  a  template  you  want  to  edit.  The 

confirmation message will appear.

Step 2: Click the OK button to accept deleting this template or click  Cancel button to 

discard this action.

4.3.4 Drives Management
The function is used to manage drives in the File Explorer. It allows adding, editing and deleting 

drives.

Go to Sites Administration → Content Presentation → Manage Drives
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4.3.4.1 Add a new drive
Do as follows:

Step 1: Click the Add Drive button in the Manage Drives form to open the Add Drive 

form.

Step 2: Input a name for the new drive in the Name field. (*Required).

Step 3: Select a workspace for the drive. There are 4 available workspaces: system, 

collaboration, backup, and dms-system.
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Step 4: Select the home path for the drive by clicking the icon .

Step 5: Click the icon to select the home path. 

Step 6: Select an icon for the workspace by clicking the icon . 

Step 7: Click icon to select an icon for the workspace.

Step 8: Select permissions for groups that have access right to this drive by clicking the 
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Illustration 167: The Select icon form

Illustration 166: The Select root path form
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icon . (*Required). 

Step 9: Select/unselect the checkboxes to show/hide in drive by default.

• Show referenced document: allows viewing preference documents.

• Show non-document: allows viewing non-documents.

• Show sidebar: allows showing the sidebar.

• Show hidden node: allows showing the hidden nodes.

Step 10: Select the document type that will be created in this drive.

• Folder: you only can create a folder called nt:folder in this drive.

• Unstructured folder: you only can create a folder called nt:unstructured in this drive

Step 11: Select a node type by clicking on the icon  

The select node types form will appear like the illustration below: 
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In this step, you can enter the name you need to search in the field 'Node type name'. 

Then, click the magnifying glass icon to start searching. All the node types containing 

the search string will be displayed below. 

Mark the checkbox corresponding to the desired node type in the Select column or click 

the icon to choose all node types. If you click the icon    , the star icon will appear in the 

the field 'Allowance nodetype on left tree'. 

Click the trash icon if you want to remove the selected nodetype.

Step 11: Select the Apply Views tab.

Step 12: Select the view type that you want to be available in drive.

Step 13: Click the Save button to finish adding a new drive.
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4.3.4.2  Edit a drive

Do as follows:

Step 1: Click the icon  that corresponds to the drive that you want to edit. The Edit 

drive form will appear:

Step 2: Edit the properties of the current drive.

Step 3: Click the Save button to accept all changes.

 

You can not edit the drive name.

4.3.4.3  Delete a drive
Do as follows:

Step  1: Click  the icon  corresponding  to  the  drive  that  you  want  to  delete.  A 

confirmation message will appear.

Step 2: Click the OK button to accept deleting this drive or click the Cancel button to 

discard this action.
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4.4  Types of Content
4.4.1 Namespace Registry
The namespace is used as a prefix of node type that describes all the node type properties. 

This function allows users to register the namespace used in the system.

Go to Sites Administration → Types of Content→ Namespace Registry

Step 1: Click the Register button in the Namespace Registry form to register a new 

namespace:

Step 2: Enter the value for the Namespace Prefix field. (* Required).

Step 3: Enter the value for the Uri field. This field must be unique. (*Required).

Step 4: Click the Save button to finish registering a new name space.
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The namespace must be unique.

The namespace must not contain special characters like !,@,#,$,%,&,*,(,).

4.4.2 Manage Node Type 
The function is used to control all node types in eXo WCM.

 Go to Sites Administration → Types of Content→ Manage NodeType.

4.4.2.1 View node types

Do as follows:

Step 1: Click the icon that corresponds to a node type you want to view.
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The View Node Type Information form will appear:

Step 2: Click the Close button to exit this form.

4.4.2.2  Add node types
Do as follows:

Step 1: Open the Add/Edit Node Type Definitions form by clicking the Add button:

                                      254 of 271

Illustration 171:  The View Node Type Information form

Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
eXo WCM Administration

Step 2: Select a name space for the node. It looks like a node prefix.

Step 3: Enter a node name for the Node type name field. This field is required.

The name of node type must be unique.

The name must not contain special characters like !,@,#,$,%,&,*,(,).

Step 4: Select a value for the "Is mixin type" field.

True: this node is mixin type.

False: this node is not mixin type.

Step 5: Select a value for the Orderable child nodes field:

True: child nodes are ordered.

False: child node are not ordered.

Step 6: Enter a value for the Primary item name field.

Step 7: Super types: click to add more parent nodes.

Step 8: Property definitions: list all definition names of Property tab.

Step 9: Child node definitions: list all definition names of Child node tab.

Step 10: Click the Save button to accept adding a new node type or click the Save draft 

button to save this node type as a draft or click the Cancel button to quit.
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4.4.2.3  Export node types
Do as follows:

Step 1 : Click the Export button to open the Export Node Types form:

Step 2:  Click  Uncheck all  if  you do not want to export all node types. After clicking 

Uncheck all, this button becomes the Check all button.

Step 3: Select nodes that you want to export by ticking the checkboxes.

Step 4: Click the Export button in this form.

Step 5: Select the location in your computer to save the exported node.

You must select at least 1 node type to be exported.

If you do not want to export the node, click the Cancel button to quit this pop up.

4.4.2.4  Import node types
Do as follows:

Step 1: Show the  Import Node Type from XML file form by clicking the Import button:
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Step 2: Browse a file to upload a file.

    You must upload an Xml file.

This file is in the node type's format.

If you want to upload a different file, click the icon to delete the file which has just  been 

uploaded , then upload other files.

Step 3: Click the Upload button. 

Step 4: Tick checkboxes corresponding to the nodes that you want to import.

Step 5: Click the Import button to complete importing a node type.
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4.5  Advanced Configuration
4.5.1 Manage Queries
The function is used to manage queries. It allows adding, editing and deleting queries. 

Go to Sites Administration→ Advanced Configuration→ Manage Queries

4.5.1.1 Add a new query
Do as follows:

Step 1: Show the Add Query  form by clicking the  Add Query button in the Manage 

Queries form.
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Step 2: Enter a query name for the Name field. 

The query name must be unique.

The name must not contain special characters like !,@,#,$,%,&,*,(,).

Step 3: Select the query type.

Xpath:(XML Path  Language)  is  a  language  for  selecting  nodes.  For  example,  

/jcr:root/Documents/Live

Sql:(Structured Query Language) is a database computer language.

Step 4: Enter the statement for query. The name of node type must be unique.

Step 5: Check or uncheck the 'Enable cache results' option. If you tick this checkbox, for 
the first time you use this query to search, the result will be cached. For the second time 
you search using this query, it will show the cached results. After 45 minutes, the cache 
will be removed. 

For example: you have the query Test with statement: //element (*, nt:file). In the File 
Explorer, you have a nt:file document named File1. Execute query Test→ the result will 
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show only document File1. After that, create a nt:file document named File2 and execute 
query Test→, the result will list only document File2. After 45 minutes, the cache will be 
removed. Execute query Test→ the result will list document File1 and File2. 

Step 6: Select permissions for a group that can use this query by clicking the icon:

Step 7: Click the Save button to finish adding a new query.

4.5.1.2  Edit a query
Do as follows:

Step 1: Click the  icon corresponding to the query you want to edit. The Edit query 

form will appear:

                                      260 of 271Copyright © eXo Platform 2000-2010. All rights reserved.



eXo Content Manual 3.0
eXo WCM Administration

Step 2: Edit the properties of the selected query.

Step 3: Click the Save button to accept all changes.

  

   

• You can not edit the query name.

• You can change the query name.

• You can edit the statement.

• You can check/uncheck in 'Enable cache results'.

• You can change permissions.

4.5.1.3  Delete a query
Do as follows:

Step 1: Click the icon corresponding to the query you want to delete. A confirmation 

message will appear.
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Step 2: Click the OK button to accept deleting this query or click the Cancel button to 

discard this action.

4.5.2 Manage Scripts 
The function allows users to manage all  script  codes in the  eXo WCM and Browser 

Content system.

Go to Sites Administration→ Advanced Configuration→ Manage Scripts.

Details:

• WCM Scripts: scripts are used in WCM.

• BC Scripts: scripts are used in Content Browser.

 ECM Scripts tab

✔ To add a new script in ECM, do as follows:

Step 1: Select ECM Scripts tab in the Manage Script.

Step 2: Click the Add button to open the Add/Edit script form:
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(*):required

Step 3: Enter a value for the Script content field. 

Step 4: Enter a script name for the Script Name field. 

• The script name must be unique.

• The name must not contain special characters such as !,@,#,$,%,&,*,(,).

Step 5: Click the Save button to accept adding new script.

✔ To edit an ECM script, do as follows:

Step 1: In the ECM Scripts tab, click the icon that corresponds to the script that you 

want to edit. The Add/Edit script form will appear:
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Step 2: Edit the properties in this form.

Step 3: Click  the Save to save all changes.

You can not edit the script name.

If you tick 'is Enable Version' checkbox, this script will automatically increase to 1 version after you click 
the Save button. It is displayed at the 'Base version' column in the ECM Scripts tab.

✔ To delete an ECM script, do as follows:

Step 1: In the ECM Scripts tab, click the icon  on script that you want to delete. A 

confirmation message will appear.

Step 2: Click the  OK  button to accept deleting this action or click  Cancel  button to 

discard this action.
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The BC Scripts tab:

✔ To add a BC script, do as follows:

Step 1: In the Manage Scripts, select the BC Scripts tab.

Step 2: Click the Add button to open the Add/Edit script form:

(*): required

Step 3: Input script content for the Script content field. 

Step 4: Input a script name for the Name field. 

Step 5: Click the Save button to finish adding a new script.

✔ To edit a BC script, do as follows:

Step 1: In the BC Script tab, click the icon on a script that you want to edit. 

The Add/Edit script form will appear:
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Step 2: Edit the properties that you want.

Step 3: Click the Save button to accept all changes. 

You can not edit the script name.

If you tick the 'is Enable Version' checkbox, this script will automatically increase to 1 version after you 
click the Save button. It is displayed at the 'Base version' column in the WCM Scripts'tab.

✔ To delete a BC script, do as follows:

Step 1: In the BC Scripts tab, click the icon  on a script that you want to delete. A 

confirmation message appears.

Step 2: Click the OK button to accept deleting this script or click the Cancel button to 
discard this action.

4.5.3 Manage Unlocks 
All locked nodes are listed and managed by administrators in the WCM Administration. There 

are two ways that help administrators unlock nodes: unlock nodes in the right-click menu in Site 

Explorer or unlock nodes in the WCM Administration.  

Step 1: Go to Sites Administration on the navigation bar.
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Step 2: Select Advanced Configuration → Manage Unlocks on the Admin the WCM 
main functions panel on the left, the locked nodes will be listed on the right panel.

Step 3: In the Locked Node tab on the right panel, administrators can unlock nodes by 

clicking on the icon that  corresponds to nodes which need to  be unlocked.  The 

unlocked nodes will disappear from the locked node list.

Administrators can manage and add the unlock permission for another groups and users 
in the Manage Lock tab. 

Step 4: Select the group on the Select group panel and the corresponding membership 
on the Select membership panel. The selected group will be listed in the Group and 

Users column. However, administrators can also click the icon if they want to allow 

any users to unlock nodes.
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Step 5: In case administrators want to remove the unlock permission of groups, click the 

icon  that  corresponds  to  the  group  in  order  to  remove  them  from  the  Unlock 

permission list except the group *:/platform/administrator and root.

4.5.4 Create an Action Type
The function allows managing all action nodes in the WCM system.

• Step 1: Go to the WCM Administration on the navigation bar. 

• Step 2: Select Advanced Configuration → Create an Action Type. 
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Step 3: Click the Add button to open the Action Type Form form:

Step 4: Select the action type.

Step 5: Input a name for the action.
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Illustration 179: Create an Action Type
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• The name must be started with exo.

• The name must be unique.

• The name must not contain special characters  like !,@,#,$,%,&,*,(,).

Step 6: Check/uncheck the  "is  Action Move" option:  the  action  will  has  exo:move 
property or not.

Step 7: Select an execute for the Execute field.

Step 8: The Variables field: allows creating multi-values for action. If you want to add 

more values for action, click the icon . Click the icon  to delete a value.

Step 9: Click the Save button to accept adding a new action type. 
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5  Next Steps 
This user manual has provided a thorough explanation of features and terminologies within eXo 
Content. Now that you know how to create, manage and publish web content and administer a 
website based on eXo Content, you may have more questions or want to get involved in the 
eXo  community.  The  following  links  can  connect  you  with  resources  to  learn  more  and 
contribute to the open source development process.

• Learn more about eXo Platform 3.0  

• Video demos, tutorial and more in the eXo Resource Center  

• Access another eXo documents in the eXo Wiki  

• Ask question about eXo Content in the Forums  
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